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About SpeedType 

 
SpeedType "The Extreme Word Expander" 

Version 10 

 
 
The Speedtype Software and Documention are copyrighted software and unauthorized 
duplication is prohibited. 
 
Copyright © 1994-2020 SPEEDTYPE Apopka, FL 
All Rights Reserved. 
 
SpeedType is distirbuted by: 
 
 SpeedType http://www.speedtype.com 
 2024 Majestic Woods Blvd. 
 Apopka, FL 32712 
 Tel # 925-940-9545 
 Email:  help@speedtype.com 
 
 
Technical Support 
For sales or technical assistance, please contact your authorized SpeedType representative 
directly.  Your authorized SpeedType representative is displayed in SpeedType’s About box 
(select About from SpeedType’s Help menu).   

Trademarks 

SpeedType “The Extreme Word Expander” is a trademark of SpeedType. 
Microsoft, Windows,  Windows 2000, Windows XP, Windows Vista and Windows Server are 
registered trademarks of Microsoft Corp. 
PRD+ is a trademark of Productivity Software. International, Inc. 
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What's New 

 
If you are upgrading from a previous version of SpeedType, please read the 
ST10WHATSNEW.TXT file for a description of new features. 
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Ordering and Licensing Information 

Go to www.speedtype.com and click on the Order Software option which will take you into 
the shopping cart area. Choose your item/items and follow the prompts to use your credit 
card for purchasing. We honor VISA, Mastercard, American Express, Discover.
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Warranty and License Agreement 

IMPORTANT: CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT 
BEFORE USING THIS PROGRAM.  USING THIS PROGRAM INDICATES YOUR ACCEPTANCE OF THE 
TERMS AND CONDITIONS CONTAINED IN THIS AGREEMENT. 
 
Copyright 
SpeedType 10.x for Windows (the “SOFTWARE”) is written and copyrighted © 1994-2020 and 
distributed by SPEEDTYPE (Apopka, FL; web site: http://www.speedtype.com).  The SOFTWARE 
is copyrighted material and protected by United States laws and international treaties.  All 
violators of the copyright will be prosecuted to the full extent of the law. You agree to use the 
SOFTWARE only if you had obtained the SOFTWARE from SPEEDTYPE or its authorized 
distributors or representatives.  IT IS A VIOLATION OF COPYRIGHT LAWS IF YOU OBTAIN THE 
SOFTWARE FROM ANYONE OTHER THAN SPEEDTYPE OR ONE OF ITS DULY AUTHORIZED 
DISTRIBUTORS OR REPRESENTATIVES. 
 
Copyright for the Tcl .DLL file is covered separately; the copyright notice can be found in the 
TclReadme.txt file. 
 

Distribution of Copyrighted Material Prohibited 

You may not distribute the SOFTWARE or any part thereof including the Registration ID and 
ST10.LIC files through any means without the express written permission of SPEEDTYPE. 
Registration ID's (including temporary licenses) and ST10.LIC files are copyrighted material and 
may not be posted publicly such as on the Internet.  Word lists that you create are your own 
property and you may do what you like with any word lists you create. 
 
Trial License 
After you purchase a copy of the SOFTWARE, you have a Temporary License to install and use a 
copy of the SOFTWARE on any computer for a period of fifteen (15) days.  YOU MUST REGISTER 
TO RECEIVE YOUR PERMANENT LICENSE.  When you register you indicate that you have 
thoroughly evaluated and tested SpeedType and found it to be acceptable for your particular 
purposes and will not ask for a refund in the future. 

Licensed Version of SpeedType 

THE SPEEDTYPE SOFTWARE CANNOT WORK WITHOUT A VALID LICENSE. 
TO BE PROPERLY LICENSED YOUR NAME OR COMPANY NAME MUST APPEAR IN SPEEDTYPE’S 
ABOUT BOX.  IF YOUR NAME OR COMPANY NAME DOES NOT APPEAR IN SPEEDTYPE’S ABOUT 
BOX, YOU ARE NOT PROPERLY LICENSED AND MAY BE USING AN ILLEGAL COPY OF THE 
SOFTWARE. 
 
BY PURCHASING AND USING A LICENSE YOU INDICATE THAT YOU HAVE THOROUGHLY 
EVALUATED AND TESTED SPEEDTYPE AND FOUND IT TO BE ACCEPTABLE FOR YOUR PARTICULAR 
PURPOSES. 
 
A Single User or 1-User License gives you one Licensed Copy of SpeedType which may either be 
used by a single person on one or more computers, or installed on a single workstation used 
nonsimultaneously by multiple people, but not both.  
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A Site License grants a single company the non-exclusive right to distribute up to a specified 
number of Licensed Copies of SpeedType for use within that company only.  You may install 
SpeedType on a network provided that you have purchased a Licensed Copy for each 
workstation that is connected to the network.  Licensed Copies of SpeedType may not be used 
by persons not employed with the company that purchased the site license.   
 
A PC License grants you one Licensed Copy of SpeedType which may be used only on a single 
computer and cannot be shared, transferred to or used on another computer. 

 
Transfer 
The Single User License, Site License, Registration ID's and ST10.LIC License Files are non-
transferable to other persons or companies; only the person or company named in the License 
can use the SOFTWARE with said License. 
 
Term 
This license is effective until terminated.  You may at any time terminate this Agreement by 
destroying the SOFTWARE and all copies thereof.  SPEEDTYPE also reserves the right to 
terminate this Agreement if you fail to comply with any of the terms and conditions herein.  
Should SPEEDTYPE terminate this Agreement because of your failure to comply, you agree to 
destroy or return all copies of the SOFTWARE to SPEEDTYPE or its authorized representative. 
 
Warranty 
The SOFTWARE is provided "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR ANY PARTICULAR PURPOSE.  SOME STATES DO NOT ALLOW THE EXCLUSION 
OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.  THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM STATE TO STATE.  Because of the diversity of hardware and software which 
the SOFTWARE may be used, SPEEDTYPE does not warrant that the SOFTWARE will meet your 
needs or that the operation of the SOFTWARE will be uninterrupted or error free.   IN NO EVENT 
WILL SPEEDTYPE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST 
SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE SOFTWARE.  In no event will SPEEDTYPE be held liable for the loss or 
corruption of data caused by the SOFTWARE.  In no event will SPEEDTYPE'S liability exceed the 
purchase price of the SOFTWARE. 
 
SOME STATES DO NOT ALLOW THE LIMITATION OF EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
 
Government 
This Agreement shall be governed and enforced by the laws of the State of California.  Any 
action or proceeding brought by either party against the other arising out of or related to this 
Agreement shall be brought only in a STATE or FEDERAL COURT of competent jurisdiction 
located in California. The parties hereby consent to in personam jurisdiction of said courts. 
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Licensing and Registration 

 
The SpeedType application is protected by a software time lock.  When you first install 
SpeedType, you will be given a Temporary License to use the product.  You must register within 
15 days to receive a License.  After the Temporary License expires, SpeedType will display 
reminder notices; SpeedType may stop working unless you install a valid license. 
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Licensing Fees 

Please visit the SpeedType Web Site for the latest prices at www.speedtype.com. 
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Order Forms 

Order forms and instructions are available from the SpeedType website. Please go to 
www.speedtype.com. 
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SpeedType 10.x Upgrade Order Form 

Licensed Users of SpeedType 9.x or earlier may purchase SpeedType 10.x at a discount.   
Order forms and instructions are available from the SpeedType Web Site. Go to 
www.speedtype.com and click on the Order Software option which will take you into the 
shopping cart. Choose the SpeedType 10 Upgrade option. 
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Tutorial and Demos 
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Quick Tutorial 

It is recommended that you run this quick tutorial to familiarize yourself with SpeedType. 

Start SpeedType 

Run the SpeedType application (the filename is “ST10.EXE”) by double-clicking the SpeedType 
icon in the SpeedType folder or program group.   If you are not licensed, the About box appears 
showing the number of days remaining in your evaluation period. Click the OK button to close 
the About box . SpeedType minimizes itself with its icon in the Windows System Tray (normally 
found on the bottom right corner of your computer screen.) 

Access SpeedType’s Main Window 

Press the F10 function key.  SpeedType should pop up. Alternatively, you can use your mouse to 
click on the SpeedType icon in the Windows System Tray. 

Open a SpeedType Dictionary 

SpeedType keeps its word lists in a “dictionary.”  SpeedType dictionary files have the extension 
“.SPF”. 
Open the DEMO1.SPF dictionary by choosing Open from SpeedType’s File menu. 

Add a New Keyword and Text to the Dictionary 

1. From the Dictionary menu, choose "Add..." to bring up the Dictionary Text dialog box.   
2. Enter "FX" in the Keyword box. 
3. Enter "The quick brown fox jumped over the lazy dog." in the Text to Type box.   
4. Click the OK button to save the new entry.  The new entry should appear in the Dictionary 

list box. 

Run SpeedType in the Background 

Run SpeedType in the background by clicking on the Hide button.  SpeedType is now watching 
your keystrokes and ready for use. 

Start Your Word Processor Program 

For this tutorial we will use the Windows Notepad program as our word processor.  If it isn't 
already running, run Windows Notepad. 

Don't Touch That Mouse! 

For the rest of this tutorial, we won't be needing the mouse.  For the benefit of touch typists,  
SpeedType can be used without a mouse.  Please put your mouse aside and don't touch it until 
the tutorial is completed. 

Using SpeedType with the Hot Key 

1. Type the following text into Notepad:  "TEST:" 
2. Press the F10 function key.  SpeedType should pop up with the text caret blinking in the 

Keyword box. 
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3. Type "fx" in the SpeedType's Keyword box but don't hit the ENTER key yet!.  Note that the 
phrase "The quick brown fox jumped over the lazy dog." automatically appears in the Text 
to Type box. 

4. Now press the ENTER key and watch SpeedType type the long phrase for you. 

Using SpeedType's AutoReplace Function 

1. Type the following text into Notepad:  "fx" (all lowercase).  Note that the AutoReplace 
Window pops up either above or below Notepad. 

2. Press the SPACE bar.  SpeedType should replace "fx" with the phrase "The quick brown fox 
jumped over the lazy dog." 

Using SpeedType's AutoComplete Function 

1. Type the following text into Notepad:  "f,," ("f" followed by two commas).  Note that the 
AutoReplace Window pops up either above or below Notepad. 

2. Press the SPACE bar.  SpeedType should replace "f,," with the closest keyword that begins 
with the letter "f". 

Using Alt+Ins to Add New Words 

1. Type the following text into Notepad:  "hello". 
2. Press the Alt+Ins key combination.  SpeedType should pop up and display the Dictionary 

Text (Add) dialog box with the word "hello" as both the keyword and Text to Type.  Press OK 
to close the dialog box and add the word to your dictionary. 

 
Note: Alt+Ins works only if AutoReplace is enabled and the Alt+Ins box is checked in the 
Preferences. 

Using Ctrl+Ins to Add a Block of Text 

1. Use your mouse to highlight (select) a block of text in Notepad. 
2. While holding down the Ctrl key, press the Insert key twice.  The selected text will be copied 

to the clipboard and SpeedType should pop up and display the Dictionary Text (Add) dialog 
box containing the contents of the clipboard. 

3. Press OK to close the dialog box and add the block of text to your dictionary. 
 
Note:  Ctrl+Ins works only if AutoReplace is enabled and your word processor uses the standard 
Ctrl+Ins command to copy text to the clipboard. 

That’s It! 

Congratulations! You now know how to use the basic features of SpeedType!  Click the >> 
button at the top of this window to proceed to a more advanced demonstration.  If you have 
problems please consult the Frequently Asked Questions section and the Troubleshooting 
section in this help file.  If you need help on using this help file please press F1. 
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Demo: Using SpeedType 

The DEMO1.SPF dictionary included with the SpeedType distribution files demonstrates 
SpeedType's AutoReplace and AutoComplete functions.  DEMO1.SPF contains keywords 
representing each word in the sentence "The quick brown fox jumped over the lazy dog."  For 
this demonstration to work, the "Automatic Keyword Completion" option must be selected in 
the Preferences box and the AutoReplace box in SpeedType's main window must also be 
selected. 
 

Warning:  DEMO1.SPF will be overwritten if you reinstall SpeedType.   If you modify 
DEMO1.SPF, be sure to save it under a different name by choosing Save As from 
SpeedType's File menu.   

 
To run the demo: 
 
1. Open DEMO1.SPF by choosing Open from SpeedType's File menu. 
2. Make sure that the AutoReplace box (above the Keyword box in the Main Window) is 

checked. 
3. Open Notepad. 
4. Type this in Notepad:   
 
 T <Space>  
 
   SpeedType should expand this to "The ". 
 
5. Now try to type this: 
 
 jump.. <Space> 
 
 SpeedType will expand this to "jumped".  This illustrates how you can define keywords for 

suffixes by using a non-alphanumeric character as the first character of the keyword.  In this 
case we use the keyword ".." (two periods) to represent "ed". 

 
6. Type this  in Notepad: 
 
 s;man <Space>  
 
 SpeedType expands this to "superman".  This illustrates how you can define keywords for 

prefixes by using a non-alphanumeric character as the last character of the keyword.  In this 
example, the "s;" keyword in DEMO1.SPF is used to represent the prefix "super". 

 
7. Keywords shorten the number of characters you need to type but require you to memorize 

the keywords to use them effectively.  To solve this problem, SpeedType has an 
"AutoComplete" feature that automatically matches the current word to the nearest 
keyword whenever you type two or more commas.  Try typing the following four characters 
("q" followed by two commas and a space) in Notepad: 

 
 q,, <Space> 
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 SpeedType expands this to "quick" which is text of the first keyword in the DEMO1.SPF 

dictionary that begins with the letter "q".  Now try this: 
 
 q,,, <Space> 
 
 SpeedType expands this to "quiet" which is the text of the second keyword in DEMO1.SPF 

that begins with "q".  If you type four commas after the "q", SpeedType will find the third 
keyword that begins with "q" and so on.   

 
 Note that  "q,,",  "qu,,", "qui,," and "quick,," will all be replaced by "quick" in this example. 
 
 If you look at DEMO1.SPF you may notice that we defined the text "quick" to be represented 

by the keyword "quick .".  You may wonder why there is an extra space and period at the 
end of the keyword.  The reason is that AutoReplace does not recognize keywords that 
contain spaces; if we had defined the keyword to be simply "quick", SpeedType would insert 
"quick" whenever we typed "quick".  This is obviously redundant so we appended the extra 
space and period to make the keyword "invisible" to AutoReplace but still accessible 
through the AutoComplete function. 

 
8. To quickly add words into the dictionary press Alt+Ins immediately after typing the word you 

want to add.  Try typing this in Notepad: 
 
 quickly <Alt+Ins> 
 
 SpeedType will add the word "quickly" to the dictionary. 
 
9. There are times when you want to insert a keyword without expanding it.  To do this press 

Ctrl+Space instead of the Space bar.  Ctrl+Space tells SpeedType to insert a space without 
expanding the keyword  To demonstrate this, type the following line in Notepad: 

 
 T <Ctrl+Space> 
 
 To expand a keyword without inserting a space, press TAB.  This is useful for adding suffixes 

to end of keywords.  To demonstrate this, try typing the following line: 
 
 T <tab> refore 
 
 Ctrl+Space is a special AutoReplace command.  But what if you want to enter the actual 

Ctrl+Space keystroke?  For example, Microsoft Word uses Ctrl+Space to reset the character 
fonts; since SpeedType intercepts all Ctrl+Space keystrokes MS Word never receives the 
keystroke so how do we send Ctrl+Space to Microsoft Word?  The solution is to remap your 
keyboard by defining a keyboard shortcut in SpeedType to simulate  Ctrl+Space.  Press F10 
to bring up SpeedType and look at the keyword named "ctrl + space" in DEMO1.SPF which 
defines Ctrl+Alt+Space as its keyboard shortcut.  Whenever you press the Ctrl+Alt+Space 
key, SpeedType will execute the "ctrl + space" keyword which simulates the Ctrl+Space key.  
To see this in action, bring up Microsoft Word, and try pressing Ctrl+Space and 
Ctrl+Alt+Space a few times to see the difference. 
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Demo: Using SpeedType Tags 

The DEMO2.SPF dictionary included with the SpeedType distribution files demonstrates how to 
use input tags to create dynamic text. 
 

Warning:  DEMO2.SPF will be overwritten if you reinstall SpeedType.   If you modify 
DEMO2.SPF, be sure to save it under a different name by choosing Save As from 
SpeedType's File menu.   

 
Open DEMO2.SPF by choosing Open from SpeedType's File menu. 
 

Input Tags  

This example demonstrates the different input fields. 
To run the Input  Example: 
1. Open or Activate Notepad. 
2. Press F10 to bring up SpeedType’s main window. 
3. Type "INPUT" <Enter> in the Keyword box. 
 
Note:  SpeedType inserts long paragraphs in “spurts”.  This is because SpeedType inserts a short 

delay between a specified number of keystrokes to allow Windows to keep up; without the 
pauses, your application may drop characters.  You can change the delay in the Preferences 
box. 

Keyboard Simulation 

This example demonstrates SpeedType's ability to simulate most keystrokes with the @KEY tag. 
To run the Key Simulation Example: 
1. Open or Activate Notepad. 
2. Press F10 to bring up SpeedType’s main window. 
3. Type "MACRO"  <Enter> in the keyword box. 

Date/Time 

This example demonstrates how to use SpeedType to insert the current date or time. 
To run the Date/Time Example: 
1. Open or Activate Notepad. 
2. Press Ctrl+Alt+N in Notepad. 
3. Press Ctrl+Alt+D in Notepad. 

Advanced Pick Lists 

These examples demonstrate advanced pick lists. 
To run the Pick List Examples: 
1. Open or Activate Notepad. 
2. Press F10 to bring up SpeedType’s main window. 
3. Type "PICKLIST1"  <Enter> in the keyword box. 
4. Press F10 to bring up SpeedType’s main window. 
5. Type "PICKLIST2"  <Enter> in the keyword box. 



 28

6. Press F10 to bring up SpeedType’s main window. 
7. Type "PICKLIST3"  <Enter> in the keyword box. 
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Demo: Using SpeedType to Correct Spelling Errors 

The TYPOS.SPF dictionary included with the SpeedType distribution files contains 500+ 
corrections to common typographical errors.  This dictionary is included for demonstration 
purposes only and is intended to show how SpeedType can be used to automatically correct 
common misspelled words. 
 

Warning:  TYPOS.SPF will be overwritten if you reinstall SpeedType.   If you modify 
TYPOS.SPF, be sure to save it under a different name by choosing Save As from SpeedType's 
File menu.   

 
To run the demo: 
 
1. Open TYPOS.SPF by choosing Open from SpeedType's File menu. 
2. Make sure that the AutoReplace box (above the Keyword box in the Main Window) is 

checked. 
3. Open Notepad. 
4. Type this in Notepad:   
 
 don;t <Space>  
 
 SpeedType will replace this with "don't". 
 
Acknowledgments 
Most of the entries in TYPOS.SPF came from a public domain MS Word AutoCorrect file by Ken 
Deifik.  The SHCNV.EXE utility was used to convert the MS Word AutoCorrect entries into a 
SpeedType file. 
 
 
 



 30

Demo: Using SpeedType with Borland Delphi 

The PASCAL.SPF dictionary included with the SpeedType distribution files contains keywords 
representing common words and statements defined in the Borland Delphi (Object Pascal) 
programming language.  The keywords in this dictionary are designed to be used with the Delphi 
Code Editor. 
 

Warning:  PASCAL.SPF will be overwritten if you reinstall SpeedType.   If you modify 
PASCAL.SPF, be sure to save it under a different name by choosing Save As from 
SpeedType's File menu.   

How to Use PASCAL.SPF 

1. Open PASCAL.SPF by choosing Open from SpeedType's File menu. 
2. Make sure that the AutoReplace box in SpeedType's Main Window is checked. 
3. Choose Preferences from SpeedType's File menu and make sure that the "Automatic 

Keyword Completion" option is checked in the AutoReplace tab. 
4. Open a Delphi unit file by running Delphi. 
5. Type normally in Delphi.  SpeedType will expand keywords as you type in Delphi.  The 

keywords in PASCAL.SPF are listed in the table below.  You are free to change or add new 
keywords as you see fit (if you do, remember to save the file under a different name or else 
your changes may be overwritten if you reinstall SpeedType.) 

 
 If You Type    SpeedType Will Insert 
  { or (*    the matching  } or *)  
 == or ::    := 
 :ac    : array[low..high] of char; 
 :ai    : array[low..high] of integer; 
 :al    : array[low..high] of LongInt; 
 :ar    : array[low..high] of real; 
 :b     : Boolean 
 :c     : char 
 :i     : integer 
 :l     : LongInt 
 :r     : real 
 :s     : string 
 a,,    Abort 
 ap,,    Application 
 b,,    begin end; 
 br,,    Break 
 do,,    do begin end; 
 e,,    Exit 
 else,,    else begin end; 
 except,,    except end; 
 f,,    False 
 finally,,   finally end; 
 record,,    record end; 
 repeat,,    repeat until ; 
 t,,    True 
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 then,,    then begin end; 
 try,,    try finally end; 
 try,,,    try except end; 
 w,,    while 

Other Keywords 

PASCAL.SPF also contains numerous Delphi common  words (such as "procedure" and 
"constructor") which are intended for use with SpeedType's Automatic Keyword Completion 
("AutoComplete") function.  AutoComplete finds the nearest keyword whenever you type two 
or more commas after a word.  For example if you type "pr,,", SpeedType will replace this with 
the first keyword that begins with "pr".  If you type "pr,,,", SpeedType will replace this with the 
second keyword that begins with "pr" and so on.  As you become more comfortable with 
SpeedType, you will find yourself typing less and less characters.  For example, with the 
AutoComplete function, "b,,", "be,," and "begin,," all refer to the same keyword.  For new users, 
typing "begin,," is easy to remember, but as you gain more experience you will learn to type 
"b,," instead. 

Special SpeedType Keys 

 Press TAB after a keyword to expand the keyword without inserting a space. 
 Press Ctrl+Space after a keyword to insert a space without expanding the keyword. 
 Press Alt+Ins immediately after typing a word to add the word to the dictionary. 
 Press Ctrl+Ins twice after selecting a block of text to add the block of text to the dictionary 

(this works only if you are using the Default Keymapping or Classic IDE Editor setting in 
Delphi; the Brief and Epsilon emulation settings do not use the Ctrl+Ins command to copy 
text to the clipboard). 
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Demo:  Using the @INPUTTCL Tag 

The DEMO-TCL.SPF dictionary included with the SpeedType distribution files contains examples 
of SpeedType code that use the @INPUTTCL tag.  Some of the examples require advanced 
knowledge of Tcl programming. 
.  

Warning:  DEMO-TCL.SPF will be overwritten if you reinstall SpeedType.   If you modify 
DEMO-TCL.SPF, be sure to save it under a different name by choosing Save As from 
SpeedType's File menu.   

 
To run the demo: 
 
1. Open DEMO-TCL.SPF by choosing Open from SpeedType's File menu. 
2. Make sure that the AutoReplace box (above the Keyword box in the Main Window) is 

checked. 
3. Open Notepad. 
4. Press F10 inside Notepad to bring up SpeedType’s Main Window. 
5. Select the “age1” entry and press Enter. 
6. Repeat steps 4 and 5 for each of the other entries in DEMO-TCL.SPF.  For each entry, 

SpeedType uses the @INPUTMSG tag to display a short description of what each entry does. 
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Basic Topics 
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Getting Started 
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Introduction 

Background 

SpeedType Ver. 10 is a text/keystroke storage and playback utility designed to work 
concurrently with most Windows applications that run under Windows XP, Vista and Server 
2003.  Contact tech support if you need a version of SpeedType that works on older versions of 
Windows. SpeedType allows you to associate frequently used words, phrases and keystrokes 
with a much shorter command or keyword.  Instead of typing in the word or phrase, you simply 
type the keyword and let SpeedType insert the associated text directly into the target 
application.  With SpeedType, you can also define shortcut keys (for example, Ctrl+Alt+C) to 
quickly play back pre-defined text, keyboard macros and launch external programs.  SpeedType 
is not limited to transferring static text, SpeedType supports interactive text and document 
assembly through embedded input fields and commands (tags) that allow you to dynamically 
change the text to be transferred. 

Specifications 

Operating System: Windows XP, Vista and Server 2003.. 
Contact tech support if you need a version of SpeedType that works on older versions of 
Windows. 
Maximum Number of Entries per Dictionary: Limited only by available resources. 
Maximum Number of Dictionaries: Limited only by available resources. 
Maximum Number of Characters per Entry: 32,000 characters. 

System Requirements 

SpeedType is a 32-bit program and uses a minimum of 2 Mb of RAM; at least 32 Mb of installed 
RAM in your PC is recommended.  SpeedType should work fine on any computer that runs 
Windows XP or later. 

How SpeedType Works 

You start SpeedType as you would any Windows application and click on the Hide button to run 
SpeedType in the background.  SpeedType will monitor your keystrokes and automatically 
replace keywords as you type in your word processor. 
 
If you can’t remember a keyword or need to access SpeedType, you simply press SpeedType’s 
hot key to bring up SpeedType’s main window.  You select the text you want SpeedType to type 
for you by entering a keyword or using the mouse to select the text from a list.  If you wish, you 
may edit the text before SpeedType types it into your word processor. 
 
If you have trouble remembering keywords, SpeedType also has an Automatic Keyword 
Completion feature that will find the nearest keyword for you. 

Using SpeedType for the First Time 

SpeedType is designed to be simple to use.  It is recommended you walk through the the 
introductory tutorial to get a feel of how SpeedType works. 
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Terminology 

Keyword 

SpeedType uses the term keyword to refer to a word that you define to represent a longer word 
or text. Other programs may use the terms “alias,” "short form," "short cut," "macro name" or 
"abbreviation" to refer to what SpeedType calls a "keyword.”  SpeedType only recognizes 
keywords you actually define. 

Text to Type 

SpeedType uses the term Text to Type to refer to the text associated with the keyword. Other 
programs may use the terms "long form" or "macro" to refer to what SpeedType calls "Text to 
Type." 

Dictionary 

SpeedType stores your keyword/Text to Type entries in a dictionary. You can create more than 
one dictionary but only one can be active at any time. Other programs may use the terms "word 
list," "glossary," or "abbreviation list" to what SpeedType refers to as a "dictionary."  SpeedType 
stores a dictionary in a file with suffix “SPF”.  Only one dictionary may be active at any time. 

Hot Key 

The hot key is a special keystroke you type from within your word processor to bring up 
SpeedType.  By default, the hot key character is the F10 function key.  You can change the hot 
key character in the Preferences dialog box. 

File Shortcut 

A file shortcut is a special keystroke for launching a file.  You define file shortcuts in the 
Preferences dialog box. 

Keyword Shortcut 

A keyword shortcut is a special keystroke to represent a keyword.  You can define a keyword 
shortcut when you create or edit a dictionary entry. 

Registration ID 

When you purchase a license, you will be assigned a Registration ID which consists of the 
following three pieces of information: USER ID, # OF LICENSED USERS, and a LICENSE ID. 
The User ID is normally based on your name and address. The number of licensed users specify 
the maximum number of users for a site license.  The License ID is a unique code which 
identifies you in our records. To complete your registration you should click the Register button 
in SpeedType’s About box and enter your Registration ID exactly.   
 

Important: You should print out and keep your Registration ID in a safe place.  You may 
need to reenter your Registration ID if you reinstall SpeedType. 

ST10.LIC License File 

A License File (named ST10.LIC) contains your Registration ID and saves you the trouble of 
entering the Registration ID manually.  A License File may be given to those who purchase Site 
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Licenses to make it easier for companies to distribute licensed copies of SpeedType.  If you 
receive a ST10.LIC license file, you should place it in the same directory as the SpeedType 
(ST10.EXE) program.  SpeedType automatically detects the presence of license files whenever 
you start SpeedType.  If you don’t have a ST10.LIC License File, one will be created by SpeedType 
after you enter a valid Registration ID in SpeedType’s Registration box.  Please note that the 
ST10.LIC file contains your license and may not be distributed to unlicensed users. 
 

Tip:  You can revert SpeedType to an unregistered version by simply deleting the 
ST10.LIC file from the computer’s hard disk.  The ST10.LIC file is located in the same 
directory as the SpeedType program files. 



 38

Starting SpeedType 

Start SpeedType as you would any Windows applications by choosing it from the Windows Start 
button or clicking its icon from within the Windows Explorer.  SpeedType displays an icon in the 
Windows system tray while it is running. 
 

Tip #1:  If you place the SpeedType icon into the Windows Startup Folder, SpeedType will be 
automatically executed whenever you start Windows.   

 
Tip #2:  SpeedType usually works best if it is loaded last; that is, run SpeedType after you 
have run all other programs.  
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The Main Window 

The Main Window consists of the Main Menu, Keyword Panel and Dictionary Panel.  You can 
resize the Keyword Panel and Dictionary Panel by dragging the Separator Bar that appears 
between the panels. 

The Main Menu 

File Menu  

Provides functions to create, open and save dictionary files.  Also provides functions to change 
preferences and print the dictionary contents to a file. 

Dictionary Menu 

Provides functions to add, modify or remove dictionary entries and shortcuts.  You can duplicate 
an existing entry or move one or more dictionary entries from one dictionary to another using 
the Copy and Paste commands.  You can search for text with the Find and Search Again 
commands. You can also enable/disable links, copy protect the dictionary, and display the 
Dictionary Info Box from this menu.  SpeedType keeps the word lists in memory so any changes 
to shared word lists are not seen until you use the Refresh command to reload the word list and 
linked entries from the hard disk. 

Shortcut Menu 

Displays the file shortcuts you defined in the Preferences box.  With file shortcuts, you can open 
a SpeedType dictionary file or launch an external program with a single keystroke. 

Help Menu 

Provides help information functions.  Use the About Box to register or display information about 
the program.  Use the Statistics box to find out how many keystrokes SpeedType saved you. 

The Keyword Panel 

Keyword Box 

Enter the keyword of a dictionary in this box.  You can use the Up and Down Arrow keys to scroll 
through the keyword list; use the Ctrl+Left Arrow and Ctrl+Right Arrow keys to change 
dictionaries. 

AutoReplace Box 

If this box is checked, AutoReplace will be enabled. 

Text To Type Box 

The text associated with the keyword you entered or selected in the Dictionary list box appears 
in the Text to Type box.  You can edit the text in this box to make temporary changes that will 
not be saved to the dictionary. 
 
Restore Last: The "Restore Last" command copies the text last expanded by SpeedType. If, for 
some reason, an expansion was not done correctly you can replay the most recent expansion by 
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pressing the hot key to bring up SpeedType, right click on the Text to Type box, select "Restore 
Last" then click the Type It button. 

Type It Button 

Click this button to command SpeedType to "type" the contents of the Text to Type box into 
your word processor.  The button is disabled if SpeedType was not activated from your word 
processor. 
 

Tip:  Pressing the Enter key is equivalent to clicking the Type It button.  
 

Hide Button 

Click this button to tell SpeedType to minimize itself and run in the background.  When 
SpeedType is running in the background, it will monitor your keystrokes and expand keywords 
as you type if AutoReplace is enabled. 
 

Tip:  Pressing the Esc key is equivalent to clicking the Hide button.  
 

The Dictionary Panel 

Speed Buttons 

The speed buttons allow you to conveniently open a dictionary, save a dictionary, add a new 
entry, edit an existing entry, remove an entry, enable links and access the Preferences box.  
Moving your mouse over a button will display a hint on what the button does. 

Dictionary List Box 

Displays keywords, shortcuts and their associated text of the active dictionary.  You can toggle 
the display of the shortcuts by choosing Show Shortcuts from the Dictionary menu.  You can 
access the Dictionary menu by clicking the right mouse button inside the Dictionary List.  You 
can resize the columns by dragging the column separator line in the title row.  The color of the 
characters in the keyword column may be changed in the Display page of the Preferences box. 

Dictionary File Tabs 

Displays the names of the most recently opened dictionary files.  The tabs allow you to quickly 
open a dictionary by simply clicking on a tab.  You create a new tab by choosing Open or New 
from the File menu.  You remove the active tab by choosing Close from the File menu.  You can 
reorder the tabs by dragging and dropping a tab with the left mouse button. 
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Managing Dictionaries 
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Opening a Dictionary 

You can open a dictionary through one of several ways: 
 
1. Choose Open from the File Menu 
 
 - OR - 
 
2. Click the  button in the Dictionary Panel. 
 
 - OR - 
 
3. With the mouse over the Dictionary List Box, click the right mouse button and choose Open 
File. 
 
 - OR - 
 
4. In your word processor, press the file's shortcut key to activate SpeedType and open the file. 
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Adding New Entries to the Dictionary 

There are 4 ways to create a new dictionary entry: 
 
1. Choose Add from the Dictionary Menu  
 
 -OR- 

 
2. Press the Ins key in SpeedType’s main window.  

 
 -OR- 
 
3. Press the Alt+Ins key from inside your word processor.  (Note: For this to work, AutoReplace 
must be enabled and the Alt+Ins option must be enabled in the AutoReplace Preferences.)  
SpeedType automatically suggests a keyword for you with an optional prefix and/or suffix added 
to the keyword. 
 
 -OR- 
 
4. Use your mouse to select (highlight) the block of text you want to add in your word processor 
then press Ctrl+Ins twice.  (Note:  This works only if your word processor recognizes the Ctrl+Ins 
command to copy text to the clipboard.) 
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Duplicating an Entry 

You can duplicate (or “clone”) a dictionary item as follows: 
 
1. Select the original entry with the left mouse button.  (Note: Only one item can be duplicated 

at a time.) 
 
2. Choose Duplicate from the Dictionary menu.  SpeedType will create a new entry then 

display the Dictionary Text dialog box. 
 

Tip:  Pressing Alt+Ins in SpeedType’s main window is equivalent to choosing Duplicate from 
the Dictionary menu. 

 
3. Edit the entry then click OK to save your changes. 
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Changing a Dictionary Entry 

 
You can change an existing entry by first selecting the entry in the Dictionary list box then 
choosing Modify from the Dictionary menu. 
 

Tip:  Pressing the F2 key is equivalent to choosing Modify from the Dictionary menu. 
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Removing a Dictionary Entry 

How to Remove a Single Entry from the Dictionary 

You can remove an entry from the dictionary by first selecting the entry in the Dictionary list box 
then: 
 
Choosing Remove from the Dictionary menu. 
 
 -OR- 
 
Pressing the Del key. 
 

Tip:  If you make a mistake, you can restore the deleted entry by choosing Paste from 
the Dictionary menu. 

 

How to Remove a Block of Entries from the Dictionary 

First select a block by clicking on an entry then, while holding down the Shift key, click on the 
another entry.  All entries between the two entries should now be selected.  You can now delete 
the selected entries by: 
 
Choosing Remove from the Dictionary menu. 
 
 -OR- 
 
Pressing the Del key. 
 

Tip:  If you make a mistake, you can restore the deleted entries by choosing Paste from 
the Dictionary menu. 
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Moving Entries to Another Dictionary 

You can copy or move dictionary entries to another dictionary by using SpeedType’s built-in 
clipboard copy and paste commands as follows: 
 
1. Select the entry you want to copy with the left mouse button.  You can select a block of 

entries by holding down the Shift key and clicking on the left mouse button. 
 

Tip: To select the entire dictionary, Left Click on the first entry, scroll down to the last entry 
then Shift+Left Click on the last entry. 
 

2. Choose Copy from the Dictionary menu to place a copy of the selected item(s) to the 
clipboard.  Alternatively, you can choose Remove from the Dictionary menu to “cut” the 
selected items to the clipboard,  

 
3. Open the destination dictionary by either choosing Open from the File menu or by clicking 

on the dictionary’s tab if it was previously opened. 
 
4. Choose Paste from the Dictionary menu to write the contents of the clipboard to the active 

dictionary. 
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Using SpeedType 



 49

Word Expansion As You Type 
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Running SpeedType in the Background 

 
Run SpeedType in the background by clicking on the Hide button or by pressing Esc anywhere in  
SpeedType’s Main Window. 
 
Once it is in the background, SpeedType will monitor your keystrokes and expand keywords as 
you type.if AutoReplace is enabled.  
 
You can access SpeedType’s main window from within your word processor by pressing 
SpeedType’s hot key or by clicking on the SpeedType icon in the Windows system tray.   
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Aborting Playback 

To abort text insertion after playback has started, press the Esc key. 
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Backing Up Your Dictionaries 

It is strongly recommended that you make copies of the dictionary files and save them to a 
floppy disk or tape drive at regular intervals.  The dictionary files have the extension ".SPF" .  To 
find the location of the .SPF file, choose Info from the Dictionary menu. 
 

Manual Backups 

To save a copy of the active dictionary to a diskette or another folder, choose Copy to from the 
File menu. Note that linked entries are not part of the active dictionary and will not be copied; 
to make a copy of a linked dictionary you will need to make it the active dictionary by opening it 
first (choose Open from the File menu). 
 

Automatic Backup Files 

After you modify and save a dictionary, SpeedType automatically makes a backup copy of the 
original file.  The backup copy is saved to a file with extension ".~SP".   You can restore the 
original data by simply renaming the backup file back to its original name. 
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Statistics Box 

Choose Statistics from the Help menu to display the Statistics Box.  The Statistics box displays 
the following: 
 The approximate number of characters you typed. 
 The approximate number of characters SpeedType typed for you. 
 The estimated time you saved by using SpeedType. 
 

 Warning: The above numbers are approximate and should not be used as a way to get 
an exact count of characters actually typed. 

 

Reset Button 

Click this button to reset the counters. 

Speed Test Button 

Click this button to bring up a window for estimating your typing speed. 
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Inserting Text from the Main Window 
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Accessing SpeedType 

Bring up SpeedType’s main window from within your word processor by pressing SpeedType’s 
hot key.   
 

Important:  SpeedType can only insert text into the window from which you pressed the 
hot key.  
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Specifying the Text To Type 

In the Keyword box, enter the keyword of the text you wish SpeedType to type.  The text 
associated with the keyword appears in the Text to Type box. 
 
You can also select the Text To Type by: 
 
Selecting the desired text in the Dictionary list box. 
 
 -OR- 
 
Pressing the up and down arrow keys in the Keyword box to scroll through the dictionary list. 
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Modifying the Text To Type 

SpeedType must have been activated from within your word processor by pressing the hot key.   
 
Specify the text to type as described in "Specifying the Text to Type." 
 
You can edit the text that is to be typed by directly modifying the text in the Text to Type box.   
 

Tip:  You can change the font of the characters in the Text to Type box through the Editor 
Font button in the Display Page of the  Preferences Dialog Box. 
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Typing Text Into Your Word Processor 

 
Please Note!  SpeedType always types the text into the active window or the window from 
which you pressed the hot key.  
 
The text that SpeedType will "type" into your word processor is displayed in the Text To Type 
box (see "Specifying the Text to Type.") 
 
If the Text To Type contains {@INPUT} tags, SpeedType will pause to accept before typing the 
text. 
 
To command SpeedType to type the text into your word processor: 
 
Click the Type It button. 
 
 -OR- 
 
With the focus in the Keyword box (the text caret must be blinking in the Keyword box), press 
the ENTER key 
 
 -OR- 
 
Double-click on the text item in the Dictionary list box. 
 
 

Tip:  Use Restore Last command to replay an expansion.  You can replay the previous 
expansion by pressing the hot key to bring up SpeedType, right click on the Text to Type 
box,  select "Restore Last" then click the Type It button. 
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Advanced Topics 
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Tags 

SpeedType uses special fields called “tags” that may be embedded in the dictionary's text to 
represent special characters and commands.  The syntax of a tag is: 
 
 {@tag_name options} 
 
Notes: 
1. There must be no spaces between '{' ,'@' and tag_name. 
2. At least one space must separate tag_name and options. 
3. Each left brace '{' must have a matching right brace '}'.  Use the {@LEFTBRACE} and 

{@RIGHTBRACE} tags if you need to insert non-matching braces. 
4. SpeedType always processes the input tags ({@INPUT} and {@INPUTDATE}) first.  The non-

input tags (such as {@REM}, {@LONGDATE} and {@DELETELINE}) are always removed or 
replaced just before SpeedType transfers the text to the word processor. 

5. Unrecognized tags are typed as is. 
 
SpeedType recognizes the following tags: 

Date/Time Tags 

These tags allow you to insert the current date/time into your text. 
{@LONGDATE}  Inserts current date using Windows long format 
{@SHORTDATE}  Inserts current date using Windows short format 
{@LONGTIME}  Inserts current time using Windows long format 
{@SHORTIME}   Inserts current time using Windows short format 

Keyboard Tags 

These tags are used to simulate keystrokes. 
{@KEY}  Simulates a complete keystroke 
{@KEYDOWN}  Simulates a key press. 
{@KEYUP}  Simulates a key release. 
{@PAUSE}  Inserts a pause between keystrokes 

User Input Tags 

These tags display a dialog box and waits for user input. 
{@INPUT}  Displays a text input dialog box 
{@INPUT} with Pick 
Lists  

Displays a pick list input dialog box 

{@INPUTMSG}  Displays a message 
{@INPUTDATE}  Displays a calendar input dialog box 

Miscellaneous Tags 

{@INPUTFILE}  Inserts a text file 
{@INPUTTCL}  Executes a Tcl script 
{@NOSPACE}  Prevents a space from appearing after expansion 
{@DELETELINE}  Deletes the entire line that contains this tag 
{@REM}  Used to embed comments in your text definitions 
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{@LEFTBRACE}, 
{@RIGHTBRACE}  

Inserts a left  (‘{‘)or right (‘}’) brace 

 
 
 
The SpeedType tags are described in more detail in the Reference section. 
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AutoReplace 

When AutoReplace is enabled, SpeedType automatically replaces keywords as you type them in 
your word processor; there is no need to press the leading hot key.  You enable AutoReplace by 
checking the AutoReplace box in SpeedType's Main Window. 

How AutoReplace Works 

As you enter characters in your word processor, SpeedType monitors your keystrokes.  When a 
recognized keyword is detected, SpeedType will generate a visual cue.  You can disable the 
visual and audible cues in the Preferences box.  If you press the Enter, Space or Tab key or type a 
non-alphanumeric character, SpeedType will simulate backspaces to erase the keyword in the 
word processor and replace it with the keyword's text to type. 

Adding Words to the Dictionary 

If AutoReplace is enabled and the Alt+Ins option is enabled in Preferences, pressing Alt+Ins will 
add the current word into the dictionary.  To copy a block of text to the dictionary, use the 
mouse to select (highlight) the text and press Ctrl+Ins twice.  This works only if your word 
processor uses the Ctrl+Ins command to copy text to the clipboard. 

Preventing Keyword Replacement 

You can prevent a keyword from being replaced by pressing Esc or Ctrl+Space. 

AutoReplace Key Groups 

AutoReplace classifies keystrokes into five groups: 

ALPHANUMERIC CHARACTERS 

This group is composed of all alphabetic and numeric characters plus the underscore ("_") 
character.  SpeedType uses the Windows language driver to determine if a character is part of 
the alphabet.  Keywords are normally composed of alphanumeric characters. 

SEPARATOR CHARACTERS 

This group is composed of the visible non-alphanumeric characters used to separate words.  
SpeedType will normally expand keywords whenever you type a SEPARATOR character after a 
keyword.  SEPARATOR characters include all punctuation marks and non-alphanumeric 
characters: 
 . , : ; " ' / ? < > - + = | \ | ( ) { } [ ] ~ ` ! @ # $ % ^ & * 
 
Note: The comma character is treated differently if the AutoComplete option is enabled. 

TERMINATOR CHARACTERS 

This group is composed of the non-visible characters used to separate words.  SpeedType will 
expand keywords whenever you press a TERMINATOR key after a keyword.   The TERMINATOR 
keys are: 
Space, Enter, Tab, Ctrl+Enter, Ctrl+Tab, Shift+Space 
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Important:  AutoReplace will not work properly if you select a TERMINATOR key to be a 
hot key or shortcut key. 

CONTROL CHARACTERS 

This group is composed of the command-type keystrokes.  SpeedType clears its internal 
keystroke buffer whenever you press a Control character.  Control characters include: Function 
keys, arrow keys, Ctrl+keys (except for those defined as Terminators), Shift+Tab, Alt+keys, 
Insert, Delete, PgUp, PgDn, Home, End, Esc, and all SpeedType shortcut keystrokes.  Mouse 
clicks will clear the internal keyboard buffer if the Support On-Screen Keyboards option (in 
AutoReplace Preferences) is disabled. 

SPECIAL CHARACTERS 

This group is composed of keystrokes which are treated as special commands by AutoReplace.  
The keys in this group are: Tab, Ctrl+Space, Alt+Ins, Ctrl+Ins, Esc. 
 Pressing Tab after a keyword will expand the keyword immediately (NOTE: Previous versions 

of SpeedType used the Shift+Enter key to expand keywords immediately; it is recommended 
you now use the Tab key instead of Shift+Enter.) 

 Pressing Ctrl+Space after a keyword will insert a space without expanding the keyword. 
 Pressing Alt+Ins will add the current word to the dictionary. 
 Pressing Ctrl+Ins twice (Ctrl+Ins+Ins) will add the selected text to the dictionary (this works 

only if the word processor uses Ctrl+Ins to copy text to the clipboard). 
 Pressing Esc will clear the keystroke buffer.  The Esc character is passed to the word 

processor only if the keystroke buffer is empty. 
 
Note: The Preferences box has options to prevent AutoReplace from processing the Ctrl+Space 

and Alt+Ins keys. 

Keyword Identifiers 

In SpeedType, keywords can be any string of up to 32 characters.  However, to make a keyword 
recognizable to AutoReplace, a keyword must be normally composed of only ALPHANUMERIC 
characters.  For example “abc” and “123” are valid AutoReplace keywords, but “my macro” will 
not be recognized by AutoReplace because of the presence of the space. 

SEPARATOR Characters in Keywords 

Under certain circumstances, AutoReplace will recognize keywords that contain SEPARATOR 
characters. 
 
1. A SEPARATOR character will be recognized as part of a keyword if it is identical to the 

preceding character in the current word.  For example, if you type //, the second / is not 
considered a SEPARATOR character.  The purpose of this exception is to allow you to define 
keywords such as ,,, to represent common word endings. 

2. A SEPARATOR character will be recognized as part of a keyword if the SEPARATOR character 
is the first or last character of the keyword.  For example, “asap!” and “=123” will be 
recognized by AutoReplace as keywords.  This rule can be used to define keywords with 
embedded SEPARATORS.  For example, “a/1“ will be recognized as a keyword if you have 
another keyword called “a/”. 



 64

 
The best way to understand all this is to experiment with SpeedType and see which keywords 
work and which do not. 

Defining Keywords for Prefixes and Suffixes 

Keywords representing prefixes should normally end with a SEPARATOR character.  Keywords 
representing suffixes should normally begin with a SEPARATOR character.  For example if you 
define “s/” to represent "super" and “,t” as the keyword for "ite", typing "s/man" will result as 
"superman" and "krypton,t" will be replaced by "kryptonite". 
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Automatic Keyword Completion 

If you have a hard time remembering keywords when using AutoReplace, SpeedType has an 
AutoComplete function that automatically finds the nearest keyword for you.  You enable 
Automatic Keyword Completion ("AutoComplete") by performing the following steps: 
 
1. From SpeedType's File menu, choose Preferences. 
2. Select the AutoReplace tab. 
3. Check the Enable Automatic Keyword Completion box. 
4. Enable the AutoReplace Window by choosing either the Show Window Only if Keyword 

Detected option or the Always Show Window option. 
5. Choose OK to close the Preferences box. 
6. In SpeedType's Main Window, make sure that the AutoReplace box is checked. 
 
When AutoComplete is enabled SpeedType will find the nearest keyword whenever you type 
two or more commas after a word.  For example, let's say you have a dictionary that contains 
the following three entries: 
 

Keyword Text to Type 
compute compute 
computer computer 
computerize computerize 

 
Now if you type com,, ("com" followed by two commas), SpeedType will match this to the first 
keyword that begins with "com" which is the "compute" keyword in our example.  If you type 
com,,, ("com" followed by three commas), SpeedType will match this to the keyword 
"computer" which is the second keyword that begins with "com".  Similarly, com,,,, will be 
matched to the keyword "computerize".   
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AutoReplace Suggestion Window 

 
To enable the Suggestion Window, choose Preferences from SpeedType’s File menu, choose the 
“4. AutoReplace” tab then check the Show Suggestion Window box.  The AutoReplace box in the 
Main Window must also be checked for the Suggestion Window to appear. 
 
The Suggestion Windows allows you to complete a keyword by pressing a selection key from a 
list of suggestions.  The selection key is F1 for the first suggestion, F2 for second suggestion and 
so forth (you can optionally change this to Ctrl+F1 or Alt+F1 through Preferences).   
 

Warning #1:  When the Suggestion Window is visible, the selection key always takes 
precedence over the hot key and other shortcut keys.  

 
Warning #2:  Older computers may not be fast enough to process your keystrokes and 
display suggestions simultaneously.  We suggest you do not display the Suggestion Window 
if you experience slow performance. 

 
Tip:  You can change the font of the text in the Suggestion Window as follows: choose 
Preferences from SpeedType’s File menu, click on the Display tab, click on the Suggestion 
Font button. 

Popup Menu 

You access the Suggestion Window’s options menu by clicking the right mouse button anywhere 
in the window.   

Bring Up Main Window 

Select this option to bring up SpeedType’s main window. 

Hide Temporarily 

Select this option to temporarily hide the Suggestion Window.  The Suggestion Window will 
reappear when you bring up SpeedType’s main window by pressing the hot key (F10 by default). 

3 Columns/1 Column 

Use these options to select either a 3 column or 1 column format for the suggestions. 

Preferences 

Select this option to bring up SpeedType’s Preferences dialog box. 

About 

Select this option to show SpeedType’s About box. 

Example 

If you open the DEMO1.SPF dictionary and type an “a” in your word processor, the Suggestion 
Window would look something like: 
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The first line shows the contents of the keyboard buffer (i.e. the word you are typing).  In the 
above example, we had just typed an “a”. 
 
The next 3 lines show the 9 nearest matching keywords with the corresponding selection keys 
(F1 .. F9).  In the above example, the nearest matching keyword to “a” is “asap”.  If you press 
“F1”, SpeedType will replace the “a” with “as soon as possible” into your word processor.  
Similarly, if you press “F6”, SpeedType will replace the “a” with “fox”. 
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Linking Dictionaries 

SpeedType allows you to access the entries in other dictionarie by linking the contents of 
another dictionary into the active dictionary.  The most common use of linking is to place 
common entries (such as your name) into a separate dictionary and linking this common 
dictionary to all your active dictionaries. 
 
You specify the dictionaries to link as follows: 
 
1.  Choose Preferences from SpeedType’s File menu. 
2.  Choose the “5. Links” tab. 
3.  Enter the dictionaries to link in the list by clicking on the Add button. 
4.  Enable the links by checking the Enable Links box.    
 

 Important:  If the Enable Links box is not checked, no linking will occur. 

Linking Rules 

SpeedType follows these rules to link entries: 
1. All the entries in the active dictionary (i.e. the dictionary which you opened and whose 

name appears in the title bar of SpeedType’s main window) are loaded first. 
2. SpeedType then loads in the dictionaries in the order specified in the list shown in the “5. 

Links” tab in the Preferences window. 
3. Duplicate keywords are always ignored and not loaded. 
4. Duplicate shortcut keys are removed. 
5. Linked entries are marked “read-only” and cannot be modified or removed. 

Example 

Linking is best illustrated with an example.  Let’s say you have three dictionaries set up as 
follows: 
 

D1.SPF: D2.SPF: D3.SPF: 
a1 = A1 (D1.SPF) a3 = A3 (D2.SPF) a3 = A3( D3.SPF) 
a2 = A2 (D1.SPF) a4 = A4 (D2.SPF) a4 = A4 (D3.SPF) 
a3 = A3 (D1.SPF)  a5 = A5 (D3.SPF) 

 
Next, we specify D2.SPF and D3.SPF as linked dictionaries by choosing Preferences from 
SpeedType’s File menu, seleting the “5. Links” tab, and adding D2.SPF and D3.SPF to the list.  
The list would therefore contain the following 2 items: 
 
       D2.SPF 
       D3.SPF 
 
Now if we open D1.SPF (by choosing Open from SpeedType’s File menu), the Dictionary List in 
SpeedType’s Main Window would contain the following items: 
 
       a1 = A1 (D1.SPF) 
       a2 = A2 (D1.SPF) 
       a3 = A3 (D1.SPF) 
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       a4 = A4 (D2.SPF) 
       a5 = A5 (D3.SPF) 
 
Note the following: 
1. SpeedType loads the dictionaries in the following order: D1.SPF (the active dictionary), 

followed by D2.SPF and D3.SPF. 
2. The “a3” keywords from the D2.SPF and D3.SPF dictionary is not loaded into SpeedType 

because “a3” already exists in D1.SPF 
3. The “a4” keyword from the D3.SPF dictionary is not loaded because “a4” was already loaded 

from D2.SPF. 
4. The “a4” and “a5” keywords are marked read-only and cannot be removed or modified.  If 

you wish to modify linked entries you will need to open the dictionary that contains the 
entry. For example, to modify “a5”, you will need to open D3.SPF. 
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Protecting Your Dictionaries 

If you want to prevent unauthorized access to your dictionary, you can protect the SpeedType 
(.SPF) file by choosing Protect from SpeedType's Dictionary menu.   

License ID 

This is the SpeedType LICENSE ID shown in SpeedType’s About Box.  By specifying a License ID in 
this box only the user with the specified LICENSE ID can read (but not modify) the file.  
The author (i.e. the person who last saved the dictionary) always has full access to the dictionary 
so specifying your own LICENSE ID in the Protect box won't prevent you from modifying the 
dictionary.  If your company is using a Site License, you only have a single Site License ID that is 
shared among multiple users; to protect a shared dictionary, you will need to purchase a 
personal 1-User SpeedType License, run SpeedType using the 1-User SpeedType License ID and 
enter your company's Site License ID in the Protect box to prevent other's from modifying the 
dictionary. 
 
To allow a user who is using an evaluation copy of SpeedType to read (but not modify) the file, 
enter “EVAL” as the License ID.   
 
To allow any user to read and modify the file (i.e. allow unprotected access) , specify a blank 
string for the License ID.   

3 Lines 

You can enter anything you want in these 3 lines.  The information you enter here will be 
displayed when the user chooses Info from SpeedType’s Dictionary menu.  Common uses of 
these lines are to enter your name and copyright information. 
 

Tip: You can choose Info from the Dictionary menu to view the protection settings. 
 

Warning:  Since the protection scheme is based on the SpeedType License ID, it is important 
that you keep your License ID in a secure place since anyone with access to your License ID 
may be able to read your protected files!  You can view your License ID by choosing  About 
from the Help menu and clicking on the REGISTER button.  Losing your License ID may result 
in your inability to access your file. 
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How to Simulate Underlined or Bold Text 

SpeedType can only simulate keystrokes and has no concept of the fonts associated with 
keystrokes.  To simulate changing fonts, you will need to find out the keystroke commands in 
your word processor to change to the desired font.  For example, Microsoft Word uses Ctrl+B to 
enable/disable bold face.  So to simulate bold text with SpeedType in Microsoft Word, you 
simply need to simulate the Ctrl+B keystroke.  Here’s an example: 
 
Keyword:  any_keyword 
Text to Type: This is {@KEY Ctrl+B}bold{@KEY Ctrl+B}. 
 
You can use the same concept to add any formatting codes to your SpeedType text. 
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Inserting ASCII Codes 

You can insert any ASCII character (including extended characters) by pressing the Alt+ASCII 
Code combination on the numeric keypad.  For example, you can insert the Copyright symbol 
"©" (ASCII Code 0169) as follows: While holding down the Alt key, type "0", "1", "6", "9" on the 
numeric keypad. 
 
Alternative Methods: 
You can bring up the Windows Character Map Application (CHARMAP.EXE, normally located in 
the Windows Accessories folder) and cut and paste the desired character directly into 
SpeedType. 
 
 -OR- 
 
You can use your word processor (e.g. choose Symbol from the Insert menu in Microsoft Word) 
to create the special character then copy and paste the character to SpeedType. 
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Effect of Keyboard Activity during Playback 

 
For most cases SpeedType is able to complete playback before you type your next keystroke.  
However, if you are a very fast typist or if SpeedType is playing back long paragraphs, it is 
possible that you may type a keystroke before SpeedType has finished the expansion.  This 
section explains how SpeedType handles your keystrokes when SpeedType is in the middle of a 
text expansion. 
 
If you type something while typing a key while SpeedType is playing back text, SpeedType will 
save most keystrokes and play them back after SpeedType is finished expanding the text.  
However, some “system” keystrokes you make during playback can cause undesired effects: 

Esc Key 

Pressing the ESC key during playback will abort playback. 

Shift, Ctrl, Alt Keys 

Pressing or releasing the Shift, Ctrl or Alt keys during playback will normally not affect the 
output. 

Caps Lock 

The effect of having CAPS LOCK key enabled depends on the method of text transfer.  If you use 
the Clipboard to transfer text, the CAPS LOCK key has no effect.  If the text is transferred 
through keyboard simulation, the state of the CAPS LOCK key affects how the text appears; 
pressing or releasing CAPS LOCK with SpeedType during text playback may result in partial caps. 

Num Lock, Scroll Lock, Print Screen, Pause/Break Keys 

Pressing or releasing these keys during playback can cause undesired results. 

Alt+Tab, Windows Keys 

Pressing these keys during playback usually results in activating a new window.  For example, 
Alt+Tab will switch to the next window while WIN+E will bring up the Windows Explorer.  Since 
SpeedType will insert text into the active window, pressing the Alt+Tab or Windows key during 
playback may cause keystrokes to be sent to the wrong window. 
 

Warning:  Sending keystrokes to the wrong window may overwrite or delete data. 
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Using SpeedType on a Network 

 
It is possible to run SpeedType on a network to be shared among 2 or more users 
simultaneously. 

Installing SpeedType 

If you are using a peer-to-peer network with not too many users, we recommend you install a 
separate copy of SpeedType for each user (i.e. each user has their own copy of SpeedType).   If 
you have many users or are using a thin client network (e.g. Windows Terminal Services or 
Citrix), you will need to install SpeedType on the server machine as thin client PC's normally 
contain security features that prevent SpeedType from working. 

SpeedType Dictionary Files 

You can place the SpeedType dictionary (*.SPF) files anywhere on the network. When 
SpeedType loads a dictionary, SpeedType does not lock the file so it is possible to lose data 
when 2 or more users make changes to the file.  To avoid conflicts, use SpeedType's Protection 
feature to prevent a dictionary from being modified (note: to implement the protection feature, 
you need at least two different SpeedType Registration ID's -- the person who is authorized to 
modify a protected dictionary would need to use a SpeedType license number that is different 
from the other users; contact your authorized SpeedType Reseller if you need to purchase 
another license). 

SpeedType Configuration Files 

By default, SpeedType stores a user’s preferences (such as window position and the last 
dictionaries loaded) in the SpeedType program directory.  You can change the directory where 
the preferences will be stored by specifying the new directory in the SpeedType command line 
as follows: 
 
<pathToST10.EXE>  /cfg=<configurationDirectory> 
 
where: 
 
<pathToST10.EXE> is the complete path to the SpeedType executable file (ST10.EXE). 
 
<configurationDirectory> is the directory to save the configuration files. 
 
Here is an example: Let’s say you have 2 users, John and Jane, who will be sharing SpeedType on 
the same PC.  John has a directory called C:\JOHN on the PC and Jane has directory called 
C:\JANE to store her private files.  What you will need to do is create two SpeedType shortcut 
icons; one for John and another forJane.  When John wants to start SpeedType, he will simply 
double click on his shortcut icon.  When Jane wants to use SpeedType, she will double click on 
her SpeedType icon. 
 
The command line associated with John’s shortcut icon would be: 
"C:\ST10\ST10.EXE"  /cfg="C:\JOHN" 
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The command line for Jane’s shortcut icon would be: 
"C:\ST10\ST10.EXE"  /cfg="C:\JANE" 
 
Note that there are no spaces around the "=" character and double quotes are required to 
enclose ALL directory names that contain spaces. 
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How to Prevent Certain Characters from Expanding Keywords 

SpeedType will normally expand keywords whenever you type a SEPARATOR character after a 
keyword. SEPARATOR characters include all punctuation marks and non-alphanumeric 
characters: 
 . , : ; " ' / ? < > - + = | \ | ( ) { } [ ] ~ ` ! @ # $ % ^ & * 
 
You can to prevent a certain character from expanding keywords by modifying the 
SHORTHND.INI file found in your SpeedType program directory: 
 
1. Start SpeedType. 
2. Choose Preferences from the File menu. 
3. Click OK.  This will update your SHORTHND.INI file. 
4. Shut down SpeedType. 
5. Use NOTEPAD to open SHORTHND.INI. 
6. Go to the [PREFERENCES] section in the SHORTHND.INI file. 
7. Locate the ALPHACHARS= entry.  The entry should look something like: 
 

ALPHACHARS=list_of_characters 
 
Where list_of_characters can be any string (including a blank string). 
 

8. Add the characters you wish to prevent expansion to the value of ALPHACHARS. 
9. For example, if you want expansion to not take place whenever you type a slash (/), colon (:)  

or backslash (\) after a keyword, your ALPHACHARS entry should look like: 
 

ALPHACHARS=/:\ 
 

 
Note:  Commas are treated differently in SpeedType.  If you want to prevent a comma from 
expanding keywords, you will need to do two things:  (a) Add the ‘,’ character to ALPHACHARS 
and (b) uncheck the Enable Automatic Keyword Completion box in the Preferences window. 
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Tcl Scripts 

Scripts written in the Tool Command Language(Tcl) can be executed directly from a .tcl file or 
embedded in SpeedType code through the {@INPUTTCL} tag.  If you are not familiar with Tcl, 
please consult the TclReadme.txt file for more information on this powerful programming 
language.  SpeedType has extension commands for managing your dictionaries as well as some 
SpeedType parameters. 
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Tcl Extension Commands 
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Tcl Extension Commands 

 
Summary of Tcl extension commands introduced by SpeedType: 
 
run  Launches a Windows file or program. 
sh_file  Manages SpeedType dictionaries. 
sh_input  Displays an input dialog box. 
sh_list  Manages entries in the active dictionary. 
sh_screen  Manages your Windows desktop. 
sh_set  Sets SpeedType parameters. 
sh_window  Manages the SpeedType main window. 
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run Tcl Command 

 

Syntax 

run filename ?arg? ?arg ...? 

Description 

Launches or opens a Windows program or file.  Filename is the complete pathname to 
the file to open. Note that the filename must follow the Tcl convention of using forward 
slashes (/) instead of backslashes (\)  as the path separators.  arg are optional command 
line options passed to the application.  For example, this will open a text file called 
“myfile.txt” in NOTEPAD: 
 

run "c:/windows/notepad.exe" "c:/myfolder/myfile.txt" 
 
You should use the run command rather than the standard exec Tcl command to launch 
external applications from within SpeedType since unlike exec, run does not wait for the 
application to terminate before returning. 
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sh_file Tcl Command 

Syntax 

sh_file option arg ?arg ...? 

Description 

Performs one of several commands related to SpeedType file operations. The legal 
options are: 

 
sh_file 

 Returns the complete pathname of the active dictionary. The pathname follows 
the Tcl convention of using forward slashes (/) instead of backslashes (\)  as the 
path separators. 

 
sh_file open file 

Open a dictionary. Equivalent to choosing Open from SpeedType’s File menu 
and specifying file as the filename.  Note that the filename must follow the Tcl 
convention of using forward slashes (/) instead of backslashes (\)  as the path 
separators.  For example:  

sh_file open "C:/my folder/my wordlist.spf" 
 

 
sh_file close  

Close the current dictionary. Equivalent to choosing Close from SpeedType’s File 
menu. 

 
sh_file save ?filename?  

Save the current dictionary.  If filename is not specified, this is equivalent to 
choosing Save from SpeedType’s File menu.  If filename is specified, this is 
equivalent to choosing Save As from the File menu and specifying filename as 
the filename. Note that filename must follow the Tcl convention of using 
forward slashes (/) instead of backslashes (\)  as the path separators.  For 
example: 

sh_file save "D:/my folder/newfile.spf" 
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sh_input Tcl Command 

Syntax 

sh_input option prompt arg ?arg ...? 

Description 

Displays dialog boxes. prompt is a string you wish to be displayed at the top of the dialog 
box.  Returns the user input if the user clicks the OK button.  Returns the string 
“SH_CANCEL” if the user clicks on the CANCEL button.  The legal options are: 

 
sh_input string prompt ?defaultValue? 

Display an input dialog window with a one line text box.  The text box is 
initialized with the defaultValue and the user may type anything in the text box.  
Returns the contents of the text box if the user clicks the OK button.  Returns 
the string  “SH_CANCEL” if  the cancel button was clicked. 

 
sh_input memo prompt ?defaultValue? 

Display a multiline dialog window. Same as sh_input string except that a 
multiline text box is shown in the dialog window. 

 
sh_input date  prompt ?defaultValue? 

Display a date input dialog window. Same as sh_input string except that a date 
input box is shown in the dialog window. 

 
sh_input open  prompt ?-filter fileTypes? ?defaultValue? 

Display a window to open a file. Same as sh_input string except that an Open 
File dialog window is shown.  The file-selection dialog includes a drop-down list 
of file types; when the user picks a file type from the list, only files of the 
selected type are displayed in the dialog.  You can configure the file types to be 
displayed through the –filter option.  To assign file types, set fileTypes to a string 
that consists of a description and a mask separated by a vertical bar (pipe) 
character.  Do not include spaces around the vertical bar.  For example, the 
following code will display a dialog box to open only *.TXT or *.DOC files: 
 
sh_input open "Select file to open" –filter "Text files|(*.txt)|Word files|(*.doc)" 

 
sh_input save  prompt ?-filter fileTypes? ?defaultValue? 

Display a window for saving a file. Same as sh_input open except that a Save As 
dialog window is shown. 

 
sh_input list  prompt {listItems} ?{defaultSelections}? 

Display a dialog window with a picklist.  listItems is a list of strings to display in 
the picklist. defaultSelections are the index numbers of items in listItems  that 
are marked as selected when the dialog window is first displayed.  The return 
value is a list of index numbers of selected items if the user clicked the OK 
button. The return value is  “SH_CANCEL” if  the cancel button was clicked.  For 
example: 
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sh_input list "Enter color:" {red blue green}  

 
returns the list 
  

0 2 
 

if the user selected red and green. 
 
sh_input list1  prompt {listItems} ?{defaultSelection}? 

Same as sh_input list except that a single-selection picklist is shown in the dialog 
window.  The user can select only one item in the list. 

 
sh_input msg  prompt message 

Display message to the user. 
 

sh_input show ?value? 
Shows (value=1) or hides (value=0) the current input dialog window. This is 
useful if you need to temporarily hide the Input dialog window when running a 
Tcl script. 

 
sh_input spellcheck prompt text 

Displays a multi-line dialog window and then spell checks text.  Same as 
executing sh_input memo and clicking on the Spell Check button.   
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sh_list Tcl Command 

Syntax 

sh_list option arg ?arg ...? 

Description 

Performs one of several commands related to SpeedType dictionary operations. The 
legal options are: 

 
sh_list add keyword  text  ?desc?  ?shortcut?   

Add a new entry into the active dictionary.  Returns the index number of the 
new entry.  Generates an error if the entry could not be added (e.g. if the 
keyword already exists). For example:  

sh_list add "asap" "as soon as possible" "" "ctrl+a" 
 
sh_list update  keyword  text  ?desc?  ?shortcut?   

Updates an existing entry in the active dictionary.  Returns the index number of 
the updated entry.  Generates an error if the entry could not be updated (e.g. if 
the keyword is read-only). For example: abc 

sh_list update "asap" "as soon as possible" 
 
 
sh_list remove index 

Remove the index’th entry of the active dictionary. The first dictionary entry has 
an index of 0.  Returns the number of remaining entries. For example, this 
command removes the third entry: 

sh_list remove 2 
 
sh_list search keyword  

Search for keyword in the active dictionary and return it’s dictionary index 
number if found. The first dictionary entry has an index of 0. Returns -1 if not 
found. 

 
sh_list length  

Returns number of entries in the active dictionary 
 

sh_list keyword index 
sh_list text index  
sh_list desc index  
sh_list shortcut index  

Retrieve the keyword, text (i.e. Text to Type),  description and shortcut of the 
index’th entry of the active dictionary.  The first dictionary entry has an index of 
0. 

 
sh_list text index textToType 
sh_list desc index description  
sh_list shortcut index shortcut 
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Sets the text (i.e. Text to Type),  description and shortcut of the index’th entry of 
the active dictionary. The first dictionary entry has an index of 0.  Note that the 
only way to change an existing keyword is to first delete it with sh_list  remove 
then add a new entry with sh_list  add. 

 
sh_list readonly index 

Returns 1 if the index entry of the active dictionary is READONLY or 0 if the 
entry can be modified.  An entry is READONLY if:  a) the active dictionary is a 
protected dictionary or b) the entry was linked from another dictionary. 
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sh_screen Tcl Command 

Syntax 

sh_screen option arg ?arg ...? 

Description 

Performs one of several commands to manage your Windows desktop screen. The legal 
options are: 

 
sh_screen classname handle 

Returns the class name of the window with the specified handle.  Unlike a 
handle which can change every time you launch an application, an application’s 
class name is fixed so if you know an application’s class name you can use the 
sh_screen findwindow  command to get the application’s window handle.  For 
example, the following script will display the class name of the current active 
window: 
 
 # get handle of current active window  

set hwnd [sh_screen foregroundwindow]; 
 
# get class name 
set classname [sh_screen classname $hwnd]; 
 
# display classname 
sh_input msg "" "Class name: $classname"; 
return "";  
 

 
sh_screen enumwindows procName clientData 

Enumerates all top-level windows (note: child windows are not enumerated) by 
passing the handle of each window to a Tcl proc specified by procName.  
sh_screen enumwindows  continues until the last top-level window is 
enumerated or the procName proc returns 0.  clientData is a value you want 
passed to the procName proc.  The return value of sh_screen enumwindows is 
the handle of the window that stopped the enumeration.  This proc is useful for 
finding a window if you know it title (see example below). 
 
procName is the name of a Tcl proc that will be called for every top-level 
window.  The procName proc takes two arguments: hwnd and clientData : 
 
   proc procName { hwnd clientData } { 
      # your code ... 
  } 
 
hwnd is the handle to the top-level window.  clientData is the value passed to 
sh_screen enumwindows. 
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To continue enumeration to the next top-level window, the procName proc 
must return 1.  To stop enumeration, procName must return 0. 
 
The following example returns the window handle of the top-level window 
whose window title starts with the text  "SpeedType": 
 

proc myproc {hwnd clientData} { 
  set s [sh_screen windowtext $hwnd]; 
  if { [string match $clientData $s] == 1} { 
    return 0; 
  } 
  return 1; 
} 
 
# Return value is the handle of the window whose 
# title starts with "SpeedType". 
# If the search fails, 0 is returned. 
return [sh_screen enumwindows myproc "SpeedType*"] 

 
 
sh_screen findwindow className ?windowName? 

Returns the handle (a unique identification number) to the top-level window 
whose class name and, optionally, the window name (the text in the window’s 
title bar) text matches the specified strings. This command does not search child 
windows.  This command does not perform a case-sensitive search.  If 
windowName is not specified, this command will return the first window that 
matches className.  A return value of zero is returned if no window matches 
the specified class name. 
 

 
sh_screen foregroundwindow ?handle? 

Returns the handle of the active window (the window with the keyboard focus). 
If handle is specified, this command will activate and give the keyboard focus to 
the window with the specified handle.  For example, the following script runs 
notepad and sets notepad as the active window: 
 
 #launch notepad 

run notepad; 
 
# wait 1 second 
after 1000 ; 
 
# The class name of notepad.exe is "Notepad" 
set hwnd [sh_screen findwindow "Notepad"]; 
 
# bring notepad to the foreground 
if {$hwnd != 0} { 
   sh_screen foregroundwindow $hwnd; 
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} 
 
return ""; 
 

 
sh_screen iskeydown keycode 

Returns 1 if the keyboard combination specified by keycode is currently pressed 
down.  keycode is the shortcut keycode used by the {@KEY tag}.  For example, 
the following script makes sure the Shift and Alt keys are up before simulating a 
Ctrl+C copy to clipboard command. 
 
 #wait for Alt key up 

while { [sh_screen iskeydown alt] } { } 
 
# wait for Shift key up 
while {[sh_screen iskeydown shift]} { } 
 
# simulate Ctrl+C  
sh_screen key ctrl+c 

 
 

sh_screen key args 
Synthesize a keystroke that will be processed by the currently active window 
(the foreground window).  args can be one or more shortcut key codes used by 
the {@KEY} tag.  The difference between this command and the {@KEY} tag is 
that the sh_screen key command simulates the keystroke immediately while 
the {@KEY} tag simulates the keystroke only after all tags and Tcl scripts have 
been evaluated.  For example; 
 
 # simulate ctrl+b 
 sh_screen key "ctrl+b" 
 
 # simulate "hello" 
 sh_screen key "h" "e" "l" "l" "o" 
 
Tip:  Use the sh_screen iskeydown command to make sure the Ctrl, Shift, Alt 
keys are not down before simulating a keystroke. 
 

sh_screen windowtext handle ?text? 
Returns the text in the title bar (if it has one) of the window with the specified 
handle.  If text is specified, this command will change the text of the specified 
window's title bar (if it has one). 
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sh_set Tcl Command 

Syntax 

sh_set option ?value? 

Description 

Use this command to get or change SpeedType events, parameters and variables. The 
legal options are: 

 
sh_set autoreplace  ?value ? 

Enable (value=1) or disable (value=0) AutoReplace. Equivalent to checking or 
unchecking the AutoReplace box.  Returns the current state of AutoReplace. 

 
sh_set links ?value ? 

Enable (value=1) or disable (value=0) Dictionary Links. Equivalent to checking or 
unchecking the Enable Links option in the “5. Links” tab of the Preference box.  
Returns the current state of Links. 

 
sh_set suggestion_window ?value? 

Enable (value=1) or disable (value=0) the Suggestion Window. Equivalent to 
checking or unchecking the Show Suggestion Window option in the “4. 
AutoReplace” tab of the Preference box.  Returns the current state of the 
Suggestion Window. 

 
sh_set clipboard ?string? 

Read or write to the Windows clipboard.  If string is specified, this command to 
writes string to the clipboard.  Returns the current contents of the clipboard. 

 
sh_set targetWindowHandle 

Returns the Windows handle of the application that is to receive SpeedType 
text.  
See example in  sh_set onTransferDone. 
 

sh_set keyword_typed 
Returns the word typed by the user that triggered SpeedType; this can be an 
empty string if SpeedType was triggered through a keyboard shortcut (e.g. F12). 
 

sh_set lastTextToType 
Returns the last expanded text.  For example, the following entry will replay the 
last expansion: 
  
KEYWORD:  replay1 
TEXT TO TYPE: {@INPUTTCL sh_set lastTextToType} 
 

sh_set onTransfer ?script? 
Evaluates script just before SpeedType inserts a long form. For example: this 
script, if placed in Shorthnd.tcl, will replace all instances of {@PAUSE} and 
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{@KEY} with [@PAUSE} and [@KEY} whenever SpeedType expands in NOTEPAD 
(and only in NOTEPAD): 
 
# place this script in shorthnd.tcl 
proc onTransfer {} { 
  # get target window 
  set hwnd [sh_set targetWindowHandle] 
  if {[sh_screen classname $hwnd] != "Notepad"} { 
    return; 
  } 
  # get text that will be expanded 
  set s [sh_set textToType]; 
  # do the replacements 
  regsub -all -nocase "{@pause" $s {[@PAUSE} s;  
  regsub -all -nocase "{@key" $s {[@KEY} s;  
  # send the modified text back to SpeedType  
  sh_set textToType $s 
} 
# activate the event handler 
sh_set onTransfer "onTransfer"; 

 
sh_set onTransferDone ?script? 

Evaluates script after SpeedType has inserted a long form. For example. this 
shows how to define a keyword that will insert another keyword that can be 
expanded by SpeedType: 
 
     KEYWORD: t1 
     TEXT TO TYPE:  
          {@INPUTTCL  
            sh_set onTransferDone { 
               update;  
               sh_set onTransferDone {}; 
            } 
            after idle "sh_screen key a s a p "; 
            return "";  
         }{@NOSPACE} 
 
     KEYWORD: asap 
     TEXT TO TYPE: as soon as possible 
  
   If you type "t1<SPACE>", SpeedType will delete "t1" and replace it 
   with "asap" with "asap" appearing in the Suggestion Window (if it's enabled). 
   Typing a SPACE will therefore expand "asap" to "as soon as possible". 
 

sh_set targetprocess  ?processID? 
This command applies only if  the words “Limited Edition” appears next to the 
Version number in the About box. 
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Set the Windows process handle of the application that is to receive SpeedType 
text.  In the Limited Edition, SpeedType will work only with windows that have a 
process handle equal to processID. 
 

sh_set textToType ?string? 
Set or get the current contents of the Text to Type box. This command is 
normally used with the "sh_set onTransfer" event handler to modify the 
expanded text. 
 
 
 

 
 
 



 92

sh_window Tcl Command 

 

Syntax 

sh_window option arg ?arg ...? 

Description 

Performs one of several commands related to the SpeedType application and main 
window.  The legal options are: 

 
sh_window refresh 

Refresh (repaint)  the SpeedType window.  Use this command after modifying 
the dictionary to make sure the dictionary list box displays the changes to the 
user. 

 
sh_window handle 

Returns the window handle of SpeedType’s top-level (application) window.  This 
window is always inviisble and is the parent of SpeedType's Main Window. 
 

sh_window main_handle 
Returns the window handle of SpeedType’s Main Window. 
  

sh_window active_handle 
Returns the window handle of the active window in SpeedType. 

 
sh_window show  ?value?  

Show (value = 1) or hide (value = 0) the main window. The return value is the 
current state of the main window. For example, sh_window show 1  displays 
SpeedType’s main window.  
 

sh_window activate 
Activates (i.e. gives the input focus to) the SpeedType active window.  This 
command is needed only if you are switching between applications and need to 
make sure the SpeedType window gets the keyboard focus. For example, the 
following code brings up the Main Window and types "hello" in the Keyword 
box: 

sh_window activate; 
sh_window show 1 
sh_screen key "h" "e" "l" "l" "o" 

 
sh_window exit 

Shut down SpeedType. Equivalent to choosing Exit from SpeedType’s File menu. 
 
sh_window cfgdir 

Returns the configuration directory that is passed to SpeedType through the 
/cfg command line parameter.  The configuration directory is where SpeedType 
looks for the SHORTHND.INI, PAGES.CFG and HISTORY.CFG files. 
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sh_window exename  

Returns the full name (including path) of the SpeedType program file. The 
returned value follows the Tcl convention of using forward slashes (/) instead of 
backslashes (\)  as the path separators. 

 
sh_window exedir  

Returns the complete path of the SpeedType program folder. The returned 
value follows the Tcl convention of using forward slashes (/) instead of 
backslashes (\)  as the path separators. 
 

sh_window pause value 
Pauses the script for value milliseconds.   
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Reference 
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Shortcut Keys 

Shortcut keys are special keyboard combinations (e.g. Ctrl+Alt+F1) that can be linked to the 
keywords or  files.  There are four types of shortcuts: 
 
1. The Hot Key is a shortcut for displaying SpeedType’s main window and is defined in the 

Preferences.  By default the hot key is the F10 function key. 
2. A Keyword Shortcut is a shortcut for a keyword and is defined in the Dictionary Text dialog 

box.  Pressing the keyword shortcut is equivalent to typing the keyword. 
3. A File Shortcut is a shortcut for an external file and is defined in the Preferences.  Pressing 

the File Shortcut will launch that file. If the file is a SpeedType dictionary, the dictionary will 
become the active dictionary.  (NOTE: An alternative way to launch programs is to use the 
@INPUTTCL tag.) 

4. A Suggestion Shortcut is a shortcut for selecting an entry displayed in SpeedType’s 
Suggestion Window.  Suggestion Shortcuts are recognized only if the Suggestion Window is 
displayed. 

 
Shortcuts are normally recognized only when SpeedType is running in the background and not 
within one of SpeedType’s dialog boxes. 
 
It is possible (but not recommended) to have the same keystroke defined as the hot key, a 
keyword shortcut and a file shortcut.  When you press a recognized shortcut key from within 
your word processor, SpeedType uses the following sequence of rules to determine what to do: 
 
1. If the Suggestion Window is visible, SpeedType first checks if the keystroke is a selection key 

for an entry in the Suggestion Window. If it is, SpeedType immediately types the associated 
text. 

2. Otherwise, SpeedType checks if the keystroke is the hot key.  If it is, SpeedType’s main 
window pops ups and displays the current dictionary. 

3. Otherwise, SpeedType checks if the keystroke is a file shortcut.  If it is, SpeedType opens or 
launches the file. 

4. Otherwise, SpeedType checks if the keystroke is a keyword shortcut in the current 
dictionary.  If it is, SpeedType immediately types the text associated with that keyword. 

 
Warning:  AutoReplace will not work properly if you select either the Tab key, Backspace 
key, Space key or the Enter key to be a shortcut key. 
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Hot Key 

The hot key character is a special character you type from within your word processor to bring 
up SpeedType.  SpeedType must be running in the background for the hot key to work.  By 
default, the hot key character is the F10 function key.  You can change the hot key character in 
the Preferences dialog box. 
 

Warning:  AutoReplace will not work properly if you select either the Tab key, 
Backspace key, Space key or the Enter key to be the hot key. 
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Shortcut Key Codes 

SpeedType simulates a keystroke or keystroke whenever it encounters the tag "{@KEY 
keycode}."  For example, "{@KEY TAB}" simulates the Tab key and "{@KEY Shift+F1}" simulates 
pressing the F1 key while holding down the Shift key. 
 
The keycode is composed of a Key Name and one or more optional Prefixes. 
 
The Prefix can be any combination of the Ctrl, Alt or Shift keys separated by the plus '+' 
character. 
 
The Key Name is name of the key.  For example, "A" represents the A key.  The following table 
lists the names of common keys: 
 

Key Name Meaning 
A "A" Key 
4 "4" Key 
F1 F1 Function Key 
F12 F12 Function Key 
Tab Tab Key 
BkSp Backspace Key 
Esc Escape Key 
Enter Enter Key 
PgUp Page Up Key 
PgDn Page Down Key 
End End Key 
Space Space Bar 
Home Home Key 
Left Left Arrow Key 
Up Up Arrow Key 
Right Right Arrow Key 
Down Down Arrow Key 
Ins Insert Key 
Del Delete Key 
Caps Caps Lock Key 
Scroll Scroll Lock Key 
Pause Pause/Break Key 
Numpad/ "/" (divide) Key on the Numeric Keypad 
Numpad* "*" (multiply) Key on the Numeric Keypad 
Numpad- "-" (subtract) Key on Numeric Keypad 
Numpad+ "+" (add) Key on Numeric Keypad 
Numpad0 "0" Key on Numeric Keypad 
Numpad. "." (decimal) Key on the Numerick Keypad 
Numpad1 "1" Key on Numeric Keypad 
Numpad9 "9" Key on Numeric Keypad 
App Applications Key on Microsoft Natural Keyboards 
Lwin Windows Key on the left side of the keyboard 

(some keystroke combinations may not work 
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correctly) 
Rwin Windows Key on the right side of the keyboard 

(some keystroke combinations may not work 
correctly) 

 

Notes 

 The NUMLOCK keystroke can only be simulated under Windows XP and later. 
 There are no shortcut codes to simulate the following keys/key combinations: Ctrl+Alt+Del, 

and PrintScrn/SysRq.  Some combinations involving the Windows key (such as LWIN+E to 
bring up Explorer) cannot be simulated by SpeedType. 

 Some characters (such as "$" which appears on the same key as the "4" key) are shifted 
characters. For example, you can simulate the $ character with Shift+4. 

 Some shortcut codes are keyboard dependent.  For example, while Shift+4 is equivalent to 
typing the '$' character on U.S. keyboards, Shift+4 may represent some other character on 
European keyboards. 

 Use {@KEY Ctrl+Esc} or {@KEY Lwin} to simulate pressing the Start button on the Windows 
task bar. 

 

Keycode Examples: 

Ctrl+A 
Shift+Tab 
Alt+F1 
Ctrl+Alt+C 
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Tags 



 100

Tag Syntax 

SpeedType uses special fields called “tags” that can be embedded in the dictionary's text to 
represent special characters and commands.  The syntax of a tag is: 
 
 {@tag_name options} 
 
Notes: 
6. There must be no spaces between '{' ,'@' and tag_name. 
7. At least one space must separate tag_name and options. 
8. Each left brace '{' must have a matching right brace '}'.  Use the {@LEFTBRACE} and 

{@RIGHTBRACE} tags if you need to insert non-matching braces. 
9. SpeedType always processes the input tags ({@INPUT} and {@INPUTDATE}) first.  The non-

input tags (such as {@REM}, {@LONGDATE} and {@DELETELINE}) are always removed or 
replaced just before SpeedType transfers the text to the word processor. 

10. Unrecognized tags are typed as is. 
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@DELETELINE Tag 

Syntax 

{@DELETELINE} 

Description 

Deletes the entire line that contains this tag.  SpeedType will not type any line that contains this 
tag.  A line is defined as a string of characters that ends with a carriage return.  This tag is useful 
in conjunction with the {@INPUT} tags for removing blank lines from the final output. 

Example 

This line will be typed out. 
This line will not be typed out{@DELETELINE}. 
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@INPUT Tag 

Syntax 

{@INPUT prompt} 
{@INPUT prompt @WANTRETURNS} 
{@INPUT(var) prompt} 

Description 

Displays a text input dialog box to the user.  SpeedType will pause and display a dialog box to 
accept text input whenever this tag is encountered.  The prompt will appear at the top of the 
dialog box to remind the user what needs to be entered.  var is the name of an optional variable 
and is limited to alphanumeric characters ('A'..'Z', '0'..'9', '_') and must not exceed 16 characters 
in length.  If var is present, SpeedType will replace all instances of the string  "{var}" with the 
user input.   
 
@WANTRETURNS is an optional qualifier.  If @WANTRETURNS is present, the input window will 
create a new line when the ENTER key is pressed.  If @WANTRETURNS is not present, pressing 
ENTER is equivalent to clicking on the NEXT button. 
 

Advanced options 

The following optional qualifiers are also supported: 
 
@ONSHOW="script" 
This will execute the specified Tcl script whenever the @INPUT tag is displayed by SpeedType.  
 

Example 

Name:   {@INPUT(name) Please enter your name} 
Height: {@INPUT(height) Please enter your height} 
Weight  {@INPUT @ONSHOW="set myflag 0" Please enter your weight} 
Summary:  {name} is {height} tall. 
 
 

Tip:  Use Restore Last command to replay an expansion.  If, for some reason, 
SpeedType did not expand the result of your input session correctly, instead of 
repeating the entire input session, you can replay the expansion by pressing the hot key 
to bring up SpeedType, right click on the Text to Type box,  select "Restore Last" then 
click the Type It button 
 

 

See Also 

{@INPUT} with Pick Lists  
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@INPUT Tag With Pick Lists 

Syntax 

{@INPUT prompt @SINGLE @SEP=”separator_string” item_list} 
{@INPUT(var) prompt @SINGLE @SEP=”separator_string” item_list} 

Description 

Displays a Pick List Input dialog box to the user.  SpeedType will pause and display a dialog box 
containing a pick list whenever this tag is encountered in the text to type box.  The prompt will 
appear at the top of the dialog box to remind the user what needs to be entered. 
 
var is the name of an optional variable and is limited to alphanumeric characters ('A'..'Z', '0'..'9', 
'_') and must not exceed 16 characters in length.  If var is present, SpeedType will replace all 
instances of the string  "{var}" with the user input.  
 
@SINGLE is an optional qualifier; if @SINGLE is present, the user may select only one item from 
the pick list.  If @SINGLE is omitted, the user can select more than one item from the pick list; 
the selected pick list items will be separated by separator_string.  The separator_string can 
include any SpeedType tag such as {@KEY Enter}.  If @SEP is not specified, the default separator 
string is a comma. 
 
item_list specifies the strings that are to appear in the pick list.  Each item must appear on a 
separate line.  The entire string is displayed in the pick list; however if an {@REM caption} tag is 
present in a pick list item, the caption is displayed instead. 

Advanced options 

The following optional qualifiers are also supported: 
 
@ONSHOW="script" 
This will execute the specified Tcl script whenever the @INPUT tag is displayed by SpeedType.  
 
@GROUP 
If "@GROUP" is specified in the prompt line, items that begin with an asterisk "*" are non-
selectable; this is useful for adding item breaks or sub-headings in your pick list. 
 
@GROUPBOLD 
Same as "@GROUP" except that the sub-headings will always be displayed in boldface.  
 
@GROUPPRINT 
Same as "@GROUP" except that the sub-headings will be included in the output if at least one of 
it's subitems is selected (see Example #7). 
 
@AUTONUMBER 
If "@AUTONUMBER" is specified in the prompt line, all items will be prefixed with numbers; this 
allows the user to jump to an item by typing its number. 
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Examples 

Example #1: A pick list that allows only a single selection. 
 
{@INPUT Select only one color @SINGLE 
red 
green 
blue 
} 
 
Example #2: A pick list that allows multiple selections; the selected items will be separated by 
commas. 
 
{@INPUT Select one or more colors @SEP=”, ” 
red 
green 
blue 
} 
 
Example #3: A pick list that uses @REM tags to customize the displayed items.  The user will see 
a list with the items “color of an apple”, “color of grass”, “color of the sky” instead of “red”, 
“green” and “blue”. 
 
{@INPUT Select only one color @SINGLE 
{@REM color of an apple}red 
{@REM color of grass}green 
{@REM color of the sky}blue 
} 
 
Example #4: A pick list with a variable name 
 
{@INPUT(color) Select one or more colors 
red 
green 
blue 
} 
You selected: {color} 
 
Example #5: A pick list that allows multiple selections; the selected items will appear in separate 
lines. 
 
{@INPUT Select one or more colors @SEP=”{@KEY Enter}” 
red 
green 
blue 
} 
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Example #6: A pick list divided into groups; items that begin with an asterisk "*" are treated as 
group headings and non-selectable. 
 
{@INPUT Select a color @GROUPBOLD 
* Color Group 1 
red 
green 
blue 
* Color Group 2 
pink 
orange 
teal 
} 
 
Example #7: A pick list divided into groups; items that begin with an asterisk "*" are treated as 
group headings and non-selectable but will be included in the output if at least one it's subitems 
is selected. 
 
{@INPUT Select a color @GROUPBOLD @GROUPPRINT @SEP={@KEY Enter} 
*{@REM Color Group 1}{@KEY ctrl+b}Color Group 1{@KEY ctrl+b} 
red 
green 
blue 
*{@REM Color Group 2}{@KEY ctrl+b}Color Group 2{@KEY ctrl+b} 
pink 
orange 
teal 
} 
 
If you choose: "red" and "pink", the output in Microsoft Word will appear as: 
 

Color Group 1 

red 

Color Group 2 

pink 
 
Example #8: A pick list that allows multiple selections. The tcl variable "myflag" is set to zero 
whenever the input box is displayed. 
 
{@INPUT Select one or more colors @ONSHOW="set myflag 0" 
red 
green 
blue 
} 
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@INPUTDATE Tag 

Syntax 

{@INPUTDATE prompt} 
{@INPUTDATE(var) prompt} 
{@INPUTDATE prompt @LONG} 

Description 

Displays a Date Input dialog box.  SpeedType will pause and display a dialog box to accept a date 
whenever this tag is encountered in the text to type box. 
 
The prompt will appear at the top of the dialog box to remind the user what needs to be 
entered.  
 
var is the name of an optional variable and is limited to alphanumeric characters ('A'..'Z', '0'..'9', 
'_') and must not exceed 16 characters in length.  If var is present, SpeedType will replace all 
instances of the string  "{var}" with the user input.   
 
By default, the "short date format" date style is selected.  To make the "long date format" the 
default date style, specify the @LONG qualifier. 
 

Advanced options 

The following optional qualifiers are also supported: 
 
@ONSHOW="script" 
This will execute the specified Tcl script whenever the @INPUT tag is displayed by SpeedType.  

Examples 

Example #1: Display a date dialog box. 
 
Date of Birth:  {@INPUTDATE Please enter your birthday} 
 
Example #2: Display a date dialog box with "long date format" as the default date style. 
 
Date of Birth:  {@INPUTDATE Please enter your birthday @LONG} 
 
Example #1: Display a date dialog box and clears the "bday" Tcl variable. 
 
Date of Birth:   
{@INPUTDATE @ONSHOW="set bday {}" Please enter your birthday} 
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@INPUTFILE Tag 

Syntax 

{@INPUTFILE pathname} 
{@INPUTFILE(var) pathname} 

Description 

Loads and inserts a Text File.  SpeedType will replace this tag with the contents of the file 
specified by pathname.  The file must be a standard text file and may contain SpeedType tags.  
pathname should contain the complete directory (path) and filename of the text file to insert.  If 
no path is specified, SpeedType attempts to load the file from the directory where the 
SpeedType dictionary (.SPF) file resides.  If SpeedType could not find the file, the following line 
will be inserted in your text:  "{COULD NOT READ INPUT FILE: pathname}" 
 
The {@INPUTFILE} tag is useful for keeping large amounts of text in a file separate from the 
SpeedType dictionary (.SPF) file; this saves memory and results in faster loading of SpeedType 
dictionaries.  The {@INPUTFILE} tag is also useful for embedding multiline text in the item_list of 
the {@INPUT} tag. 
 
var is the name of an optional variable and is limited to alphanumeric characters ('A'..'Z', '0'..'9', 
'_') and must not exceed 16 characters in length.  If var is present, SpeedType will replace all 
instances of the string  "{var}" with the contents of the file specified by pathname.  
 

Warning:  Since inserted files may themselves contain other {@INPUTFILE} tags, you 
should watch out for the possibility of circular references in which one file inserts a 
second file which inserts the first file again.  SpeedType tries to catch this situation by 
limiting the number of {@INPUTFILE} tags that may be processed. 

Examples 

Example #1:  Insert the file "version.txt" which resides in the same directory as the  
SpeedType dictionary (SPF) file: 
 
The current version of SpeedType is Version {@INPUTFILE version.txt} 
 
Example #2:  Insert a file according to what the user selects from a picklist.  “male-report.txt” 
and “female-report.txt’ may themselves contain @INPUT tags. 
 
{@INPUT Select patient's gender 
{@REM male}{@INPUTFILE male-report.txt} 
{@REM female}{@INPUTFILE female-report.txt} 
} 

See Also 

{@INPUT}  
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@INPUTMSG 

Syntax 

{@INPUTMSG} 

Description 

Displays a message to the user.  SpeedType waits for the user to click on the Next button before 
continuing.  This tag is useful for giving instructions to the user or can be used in conjunction 
with the @INPUTTCL tag to wait for an external program launched by a Tcl script to complete. 

Example 

{@INPUTMSG Please make sure all questions are answered completely} 
 
 
 

Tip:  You can change the font of the characters in the message through the Editor Font 
button in the Display Page of the  Preferences Dialog Box. 
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@INPUTTCL Tag 

Syntax 

{@INPUTTCL script} 

Description 

Executes a Tool Command Language (Tcl) script.  Normally the script should be small and fast or 
the possibility of a system lockup may occur.  The {@INPUTTCL} tag is replaced by the result of 
the script.  If you are unfamiliar with Tcl, please refer to the TclReadme.txt file for more 
informaton on Tcl. 

Examples 

Example #1:  This example uses the Tcl clock command to get the current time and format the 
output.  If today’s date is August 19, 2000, the following SpeedType code:  
 
{@INPUTTCL clock format [clock seconds] –format “%m/%d/%y” } 
 
will be replaced by: 
 
08/19/00 
 
 
Example #2:  This example uses the {@INPUTDATE} tag to get a date from the user and a 
{@INPUTTCL} tag do some date calculations.  
 
Your birth date: {@INPUTDATE(var_date) Enter your birth date} 
Your age (in years) is: {@INPUTTCL 
  set date_string “{var_date}” 
  set date_seconds [clock scan $date_string]; 
  set now_seconds [clock seconds]; 
  set age_seconds [expr $now_seconds - $date_seconds]; 
  set seconds_per_year [expr 365 * 24 * 60 * 60]; 
  set age_years [expr $age_seconds/$seconds_per_year]; 
  return $age_years; 
} 
 
Notes: 
1. The presence of (var_date)  in the {@INPUTDATE} tag tells SpeedType to replace all 

occurrences of {var_date}  (note the curly braces) in the SpeedType text so the first line in 
the @INPUTTCL tag will set the date_string variable to the user input (note the double 
quotes around {var_date}” is important since {var_date} may contain strings. This is how you 
can pass user input into an @INPUTTCL script. 

 
 
Example #3:  Same as the previous example except that only the age is printed out and the 
result of the @INPUTDATE tag is not shown because the @INPUTDATE tag is embedded in an 
@REM tag. SpeedType never displays the contents of the @REM tag. 
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{@REM {@INPUTDATE(var_date) Enter your birth date} } 
Your age (in years) is: {@INPUTTCL 
  set date_string “{var_date}” 
  set date_seconds [clock scan $date_string]; 
  set now_seconds [clock seconds]; 
  set age_seconds [expr $now_seconds - $date_seconds]; 
  set seconds_per_year [expr 365 * 24 * 60 * 60]; 
  set age_years [expr $age_seconds/$seconds_per_year]; 
  return $age_years; 
} 
 
 
Example #4:  Use Ctrl+Shift+N as a keyboard shortcut to launch NOTEPAD using the Tcl run 
command.  
 
Keyword: run notepad 
Shortcut:  Ctrl+Shift+N 
Text to Type: {@INPUTTCL run c:/windows/notepad.exe } 
 
Note: The backslashes in pathnames must be replaced by forward slashes.  The run command is 
not part of the Tcl  core library but is a command introduced by SpeedType to replace the 
standard exec command to overcome the inability of exec to launch console (MS-DOS) 
programs. 
 
  
Example #5:  It is possible to send output from an external program to SpeedType by using 
{@INPUTTCL} together with {@INPUTMSG} and {@INPUTFILE}.  You first create a program using 
your favorite programming language then use {@INPUTTCL} to run that program.  To pass data 
to SpeedType, your program should write the data to a text file and then use the {@INPUTFILE} 
tag to tell SpeedType read and process that text file.  You use the {@INPUTMSG} tag to give 
instructions to the user and wait for the program to complete. 
 
Here is an example of SpeedType keyword definition to insert the names of the files in the 
current directory into your word processor: 
 
{@INPUTTCL run c:/tmp/test.bat}{@INPUTMSG Press Next to continue}{@INPUTFILE 
c:\tmp\out.txt} 
 
where C:\TMP\TEST.BAT is a batch file that contains the line: 
 
DIR > C:\TMP\OUT.TXT 
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@KEY Tag 

Syntax 

{@KEY keycode  count} 

Description 

Simulates a keystroke or keystroke combination represented by the shortcut keycode.  count 
represents the number of times to simulate the keystroke.  If count is omitted, SpeedType 
assumes a count of 1. 

Example 

 
Example #1:  Simulate Shift+F1. 
 
{@KEY Shift+F1} 
 
Example #2:  Simulate 3 consecutive left cursor keys. 
 
{@KEY Left  3} 
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@KEYDOWN, @KEYUP Tags 

Syntax 

{@KEYDOWN keycode} 
{@KEYUP keycode} 

Description 

Simulates a key press (@KEYDOWN) or key release (@KEYUP) of a shortcut keycode. 
 

Warning:  Every {@KEYDOWN} needs a matching {@KEYUP} or else a key may be left in 
a “stuck” position. 

Examples 

 
Example #1:  Simulate pressing A followed by S while holding down the Ctrl key. 
 
{@KEYDOWN Ctrl}as{@KEYUP Ctrl} 
 
Example #2:  Simulate Shift+F1 
 
{@KEYDOWN Shift}{@KEYDOWN F1}{@KEYUP F1}{@KEYUP Shift} 
 

See Also 

{@KEY}  
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@LEFTBRACE, @RIGHTBRACE Tags 

Syntax 

{@LEFTBRACE} 
{@RIGHTBRACE} 

Description 

{@LEFTBRACE}inserts the left brace character: '{'. 
{@RIGHTBRACE}inserts the right brace character: '}' 
These tags are useful if you need want SpeedType to type out strings that can be interpreted as 
tags such as  {@KEY}. 

Example 

The SpeedType tag for simulating keystrokes is: {@LEFTBRACE}@KEY{@RIGHTBRACE} 



 114

@LONGDATE Tag 

Syntax 

{@LONGDATE} 

Description 

Inserts current date using the Windows Long Date format.  The Long Date Format is specified in 
the Regional Settings of the Windows Control Panel. 

Example 

The current date is {@LONGDATE}. 

See Also 

{@SHORTDATE}  
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@LONGTIME Tag 

Syntax 

{@LONGTIME} 

Description 

Inserts current time using the Windows Long Time format.  The Long Time format is specified in 
the Regional Settings of the Windows Control Panel. 

Example 

The current time is {@LONGTIME}. 

See Also 

{@SHORTTIME}  



 116

@NOSPACE Tag 

Syntax 

{@NOSPACE} 

Description 

Prevents a SPACE or ENTER from appearing after SpeedType expands the keyword.  If you type a 
SpeedType keyword followed by a SPACE or ENTER in your word processor, SpeedType will 
expand the keyword and insert the SPACE or ENTER you just typed.  If you don’t want the SPACE 
or ENTER to appear, insert the {@NOSPACE} tag anywhere in the keyword definition.  The 
presence of {@NOSPACE} has the equivalent effect as if you had typed a keyword folllowed by a 
TAB to expand the keyword immediately. 

Example 

Best Regards, John Smith{@NOSPACE} 
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@PAUSE Tag 

Syntax 

{@PAUSE delayTime} 

Description 

Inserts a Pause Between Simulated Keystrokes.  SpeedType pauses for at least delayTime 
seconds whenever it encounters this tag.  delayTime is a floating point number greater than 
zero and less than 10.  A number greater than 10 will result in a pause of 10 seconds.  You may 
omit delayTime in which case SpeedType will pause 1 second.  Since Windows is not a real-time 
operating system, the actual pause will be at least, but not exactly, delayTime seconds. 

Examples 

Example #1: Insert a delay of 1 second before switching windows with the Alt+Tab command. 
 
{@PAUSE){@KEY Alt+Tab} 
 
Example #2: Insert a delay of at least four and a half seconds between "johnsmith" and 
"mypassword": 
 
johnsmith 
{@PAUSE 4.5} 
mypassword 
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@REM Tag 

Syntax 

{@REM comment} 

Description 

This tag is used to hold a comment and will not be typed. 

Example 

{@REM This is a comment} 
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@SHORTDATE Tag 

Syntax 

{@SHORTDATE} 

Description 

Inserts current date using the Windows Short Date format.  The Short Date Format is specified in 
the Regional Settings of the Windows Control Panel. 

Example 

The current date is {@SHORTDATE}. 

See Also 

{@LONGDATE}  
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@SHORTTIME Tag 

Syntax 

{@SHORTTIME} 

Description 

Inserts current time using the Windows Short Time format.  The Short Time format is specified 
in the Regional Settings of the Windows Control Panel. 

Example 

The current time is {@SHORTTIME}. 

See Also 

{@LONGTIME}  
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Frequently Asked Questions 
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Questions on Specifications 

How many dictionary entries can SpeedType support? 

The theoretical maximum number of entries in a single dictionary is 2 billion. However, the 
practical limit is much lower and depends on the amount of free memory available. Some 
people are using SpeedType with as much as 1,000,000 entries.  The number of dictionary files is 
limited only by hard disk space.  

What is the maximum number of characters that can be associated with a keyword? 

32,000 characters total. You cannot get around this limit; the text loaded by the @INPUTFILE tag 
counts toward this limit. This is a designed limitation to conserve memory; please contact 
OfficeSoft if you need to transfer large amounts of text.  
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Questions on SpeedType in General 

What is SpeedType? 

SpeedType is a text storage and transfer utility designed to work concurrently with other 
Windows applications. SpeedType allows you to represent frequently used words, phrases and 
keystrokes with a much shorter command or keyword. Instead of typing the word or phrase, you 
type the keyword followed by a punctuation mark and SpeedType will insert the text directly 
into the target application. With SpeedType, you can also define shortcut keys (for example, 
Ctrl+Alt+C) to quickly play back pre-defined text or keyboard macros. SpeedType is not limited 
to transferring static text, you can embed special fields ("tags") such as input fields, pick lists and 
date fields that allow you to dynamically change the text to be transferred.  

How does SpeedType work? 

You start SpeedType as you would any Windows application. SpeedType waits in the 
background until you need it. You start your word processor and begin typing normally. 
SpeedType will automatically replace keywords as you type. If you need to bring up SpeedType, 
you can simply press a pre-defined hot key (normally F10 unless you changed it) and SpeedType 
pops up and takes control. You can then specify the text you want SpeedType to type for you by 
entering a keyword or using the mouse to select the text from a list. If you wish, you may edit 
the text before SpeedType types it into your word processor.  

What's the difference between SpeedType and my word processor's macros? 

SpeedType and your word processor's macros have the same purpose--to reduce the number of 
keystrokes you need to type commonly used words. SpeedType has the advantage that it is not 
tied to a single word processor--you can use it with just about every Windows word processor, 
text editor, and even with text edit boxes within dialog boxes. SpeedType is designed to be 
much easier to use than the macro abilities of most word processors (which usually requires 
programming); much work has gone into designing a user interface that is readily usable by both 
touch typists and "hunt-and-peck" typists.  

Can SpeedType really work with almost all Windows GUI applications? 

SpeedType uses the Windows hooks mechanism to monitor and insert characters into the 
Windows keyboard message queue. Virtually all Windows GUI (Graphical User Interface) 
applications uses the standard Windows keyboard message queue and SpeedType should work 
well with these applications.  

Will SpeedType work with Windows 2000 and earlier? 

SpeedType 10 is designed to run under Windows XP, Vista and Server 2003.  SpeedType 10 may 
work with Windows 2000 and eariler but this has not been fully tested. Please contact tech 
support if you need a version of SpeedType that works on older versions of Windows. 

Does SpeedType work with DOS programs? 

There is a third party utility called TameDOS (http://www.tamedos.com) that may make 
SpeedType work with DOS programs. 
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So what applications are incompatible with SpeedType? 

SpeedType may not work correctly with:  
 DOS, System Console and other "text only" windows.  
 Applications with built-in abbreviation expansion (such as the Microsoft Word AutoCorrect 

wizard). If you are using SpeedType with MS Word, be sure to disable the AutoCorrect 
wizard.  

 Applications (such as some terminal emulators) that do not understand the BACKSPACE key; 
for such applications, you can still use the SpeedType hot key to insert text--press F10 to 
bring up SpeedType, select your keyword then press the Type It button to insert the text.  

 Applications (such as anti-spyware, spell checkers and clipboard utilities) that monitor your 
keystrokes. 
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Questions on Running SpeedType 

Is it possible to run SpeedType automatically whenever I start Windows? 

Yes. Place the SpeedType program icon in the Windows Startup folder to have Windows 
automatically execute SpeedType whenever you start Windows.  You should note, however, 
that SpeedType works best if it is loaded last.  If you find that SpeedType does not work 
correctly when initialized from the Windows Startup folder you should launch SpeedType 
manually. 

SpeedType doesn't work correctly with some of my applications! 

Try changing the text transfer method. SpeedType has two methods for transferring text: by 
keyboard simulation and by simulating the clipboard paste operation. If you encounter a 
problem inserting text into an application, try changing the text transfer method in SpeedType's 
Preferences box.  If you are using Microsoft Word, be sure to disable MS Word's AutoCorrect 
wizard by choosing AutoCorrect from MS Word's Tools menu and unchecking the "Replace Text 
as You Type" box. 
 
Text playback is occurring very slowly. 
Try unchecking the Verify Target Window Receives Keystrokes option in the Preferences box. 
 
SpeedType is dropping keystrokes. 
SpeedType is playing back text faster than the target window can process them. This frequently 
occurs if SpeedType plays back large amounts of text and your word processor needs to 
redisplay or scroll down the page.  Slow down SpeedType by increasing the delay between 
keystrokes to something like “Pause 100 msec after every 40 keystrokes”.  You can also insert 
{@PAUSE} tags in your SpeedType text to simulate short pauses. 

After SpeedType inserts the text, the text caret is positioned at the wrong place in the word 
processor! 

Try changing the text transfer method in SpeedType's Preference box.  

How do I change the date/time formats used by the LONGDATE, SHORTDATE, LONGTIME and 
SHORTTIME tags? 

The @LONGDATE, @SHORTDATE, @LONGTIME and @SHORTIME tags use the Windows 
date/time format; you can change the date/time format by clicking the Regional Settings icon in 
the Windows Control Panel.  You can also specify your own format using Tcl’s clock command 
within an @INPUTTCL tag. 

How do I get rid of the message that asks for confirmation whenever SpeedType exits? 

Go to the Display page in the Preferences box and check the "Do Not Confirm Exit" option.  
Display Preferences  

How can I stop SpeedType after it has started inserting text? 

Press the ESC key or use the  mouse to click on the SpeedType icon in the Windows System Tray. 
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Questions on Inserting Text with SpeedType 

How does SpeedType's AutoReplace function work? 

You enable AutoReplace by checking the AutoReplace box that appears above the Keyword box 
in SpeedType's Main Window. When AutoReplace is enabled, SpeedType watches your 
keystrokes as you type. When you type a recognized keyword the AutoReplace window pops up 
and displays the keyword and the associated text. If you type a SPACE, ENTER, TAB or a non-
alphanumeric character, SpeedType will backspace over the keyword and insert the text 
associated with the keyword directly into your word processor.  

How do I simulate bold or underline fonts with SpeedType? 

You can simulate fonts with SpeedType if your target word processor supports keystroke 
commands to change fonts. For example, since Microsoft Word uses Ctrl+B to turn bold on/off  
you can use SpeedType’s {@KEY Ctrl+B} tag to turn bold on/off. 

How do I tell SpeedType to automatically insert the closing parenthesis whenever I type the 
opening parenthesis? 

To do this define the following entry:  
 

Keyword: (  
Text to Type: (){@KEY Left} 

 
Now whenever you type a left parenthesis, SpeedType will automatically insert the left and right 
parentheses and simulate a left arrow key to place the caret at the proper position between the 
parentheses. 

 How can I define prefixes and suffixes? 

SpeedType will replace keywords when you type a non-alphanumeric character. This means that 
you can define a prefix by simply ending the keyword with a punctuation mark. Suffixes can be 
defined with keywords that begin with a punctuation mark. Here is an example:  
 

Keyword: m;  
Text to Type: micro  
 
Keyword: pc  
Text to Type: computer  
 
Keyword: ;z  
Text to Type: ization 

 
Now if you type  m;pc;z , SpeedType will expand it to microcomputerization .  

Do I have to memorize keywords to use SpeedType effectively? 

If you have difficulty remembering keywords (and who doesn't!), SpeedType has an 
AutoComplete function that finds the closest keyword. Whenever you type two or more 
commas after a word in your word processor, SpeedType will find the closest keyword that 
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begins with the word you had typed. For example if your name is "George Washington", you can 
add the following entry into your dictionary:  
 

Keyword: george  
Text to Type: George Washington 

 
Now if you type g,, ("g" followed by two commas), SpeedType will match this to the closest 
keyword starting with "g", which is the george keyword (assuming you have no other keyword 
starting with "g"). Note that the same result will be true if you had typed ge,, ,  geo,,  or even 
george,, .  

SpeedType doesn't seem to recognize keywords with embedded punctuation marks such as 
"don;t". 

SpeedType normally treats non-alphanumeric characters as word separators that mark the 
beginning or end of a word. So if you type don;t , SpeedType sees this as two words ("don" and 
"t") separated by a semi-colon. However there is a way to get around this. SpeedType will treat 
the semi-colon as part of the keyword rather than a word separator if you define the following 
entry:  
 

Keyword: don;  
Text to Type: don; 
 

So if you want SpeedType to replace don;t  with  don't  you should define two entries:  
 

Keyword: don;t  
Text to Type: don't  
 
Keyword: don;  
Text to Type: don; 

 
Similarly, to have SpeedType replace the word  we;re  with  we're , you will need three entries:  
 

Keyword: we;re  
Text to Type: we're  
 
Keyword: we;  
Text to Type: we;  
 
Keyword: we;r  
Text to Type: we;r 

 
If you want to use SpeedType to automatically correct spelling errors where a semi-colon is 
typed instead of an apostrophe (such as don;t, can;t, you;re, we;ve, I;ll, etc.), you could simply 
define the following keywords:  
 

Keyword: ;t  
Text to Type: 't  
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Keyword: ;re  
Text to Type: 're  
 
Keyword: ;ve  
Text to Type: 've  
 
Keyword: ;ll  
Text to Type: 'll 
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Questions on Managing Dictionaries 

Can SpeedType use two dictionaries at the same time? 

Yes, by linking dictionaries together. 

How can I convert another file format into the SpeedType file format? 

The SHCNV.EXE utility can convert certain ASCII text, PRD, Smartype, Abbreviate! text files and 
Microsoft Word AutoCorrect entries into the SpeedType format.  

How do I print the contents of a dictionary? 

You can print the contents of a dictionary to a text file by choosing "Print to File" from the File 
Menu. 

Is there a way to conveniently add text to my dictionary? 

If AutoReplace is enabled, you can quickly add a single word to your dictionary by pressing the 
Alt+Ins key immediately after typing a word in your word processor.  To add a second form of 
the word you just added, press Alt+Ins again (if nothing happens, press Alt+Ins one more time). 
 
Alternatively, you can use your mouse to select a block of text in your word processor and then 
press Ctrl+Ins twice to add the block of text to the active dictionary (this works only if your word 
processor uses the Ctrl+Ins key to copy text to the clipboard).  

How do I copy or transfer a dictionary entry from one dictionary to another dictionary? 

Open both dictionaries and choose Copy from the Dictionary menu to copy a dictionary entry 
into the clipboard. You can then switch to the other dictionary and choose Paste from the 
Dictionary menu to insert the entry.  
 
You can move a block of entries at once by choosing an entry then, while holding down the Shift 
key, clicking on another entry.  All the entries between the two entries should now be selected 
and you can copy the block by choosing Copy from the Dictionary menu.  You can then switch to 
another dictionary and choose Paste from the Dictionary menu to insert the block. 

How do I append the contents of an entire dictionary into another dictionary? 

Choose Run File Converter from the File menu to merge two dictionaries.  

How do I prevent others from copying or accessing my dictionary? 

You can copy protect your file by choosing Protect from the Dictionary menu and entering the 
authorized person’s License ID. 
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Questions on Using SpeedType with Microsoft Word 

I get an extra space when expanding abbreviations in Microsoft Word. 

Try turning off AutoCorrect (see next question).  If that doesn't work, if you set SpeedType to 
use the clipboard to transfer text, you should be aware that, by default, MS Word adds extra 
spaces to text inserted through the clipboard.  There are two ways to get around this:  
 

From MS Word's Tools menu, choose Options, click on the Edit tab and uncheck the 
Smart Cut and Paste check box. 

 
 - OR - 

 
From SpeedType's File menu, choose Preferences and select Simulate Keystrokes as the 
text transfer method. 
 

 

Can I use SpeedType together with Microsoft Word's AutoCorrect Wizard? 

We recommend you turn off MS Word's AutoCorrect Wizard while using SpeedType. If you leave 
it on, the AutoCorrect Wizard may try to expand the text SpeedType inserts which may produce 
unexpected results.  You can disable Word’s AutoCorrect Wizard as follows: 
1. Open Microsoft Word. 
2. From the Tools menu, choose AutoCorrect. 
3. Unselect the Replace Text As You Type check box.  (You can leave the other options, such as  

Correct Two Initial Capitals, enabled.) 
4. Choose OK to apply the changes. 
 

What's the difference between SpeedType and Microsoft Word's AutoCorrect wizard? 

SpeedType has the following advantages over MS Word's AutoCorrect wizard:  
1. SpeedType works with almost all Windows applications including dialog boxes and forms. 
2. You can organize your keywords into separate dictionaries with SpeedType. 
3. SpeedType has better support for suffixes and prefixes. 
4. You can insert keystroke macros, input fields and variables in SpeedType's text. 
5. SpeedType stores its dictionary in files;  if you want two PC's to use the same dictionary, you 

simply copy the file from one PC to the other PC or can even share it over a network.  MS 
Word stores the AutoCorrect entries in system files; to transfer your AutoCorrect entries to 
another PC, you may have to write a macro or ask  someone to help you since the 
documentation (at least as of Word Version 2003) doesn't clearly tell you how to do it (and 
for a good reason: it isn't easy!). 

6. SpeedType supports automatic keyword completion if you type two or more commas after a 
word. 

 

How can I transfer my MS Word AutoCorrect entries into SpeedType? 

The SHCNV.EXE utility can do this for you.  
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The Ctrl+Space keystroke doesn’t seem to work. 

The Ctrl+Space key is an MS Word command to revert text to the normal font.  However, since 
SpeedType intercepts the Ctrl+Space key to insert a space without expanding a keyword, the 
Ctrl+Space key is not normally available to MS Word.  To get around this problem, you can 
either disable SpeedType’s use of Ctrl+Space in the Preferences box or you can remap 
Ctrl+Space to another keystroke by creating a SpeedType dictionary entry with the following 
parameters: 
  
  Keyword:  Use_Any_Name_You_Want 
  Shortcut:  Ctrl+Alt+Space 
  Text to Type:  {@KEY Ctrl+Space} 
  
Now whenever you press Ctrl+Alt+Space, SpeedType sends Ctrl+Space to MS Word. 
 

Trailing spaces at the end of inserted text are not being transferred. 

If you set SpeedType to use the clipboard to transfer text, you should be aware that, by default, 
MS Word removes trailing spaces from text inserted through the clipboard.  There are three 
ways to get around this:  
 

From MS Word's Tools menu, choose Options, click on the Edit tab and uncheck the 
Smart Cut and Paste check box. 
 
 - OR - 
 
From SpeedType's File menu, choose Preferences and select Simulate Keystrokes as the 
text transfer method. 
 
 - OR - 
 
Use the {@KEY Space} tag to simulate trailing spaces in SpeedType's text to type. 
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Troubleshooting and Technical Support 
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Technical Support 

To get technical support, contact your SpeedType representative listed in SpeedType’s About 
Box. 
 
A list of common problems and solutions are kept in the SpeedType Web Site.  Before getting 
technical support, please check the SpeedType Web Site to see if your problem is addressed 
there. 
 
Licensed users always get priority for technical support; if you are a licensed user please be sure 
to include your Registration ID (USER ID and LICENSE ID) obtained by clicking the Copy button 
found in SpeedType's About Box.  
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Compatibility Issues 

Unresponsive Keyboard 

To fix this, bring up SpeedType by using your mouse to click on the SpeedType tray icon.  Click 
the Hide button to minimize SpeedType.  This should reset your keyboard. 

Playback Problems 

If you encounter problems inserting text into an application, try selecting either Simulate 
Clipboard Paste or Simulate Keystrokes in the Preferences box. 

Dropped Characters 

By default, SpeedType plays back text at full speed.  Some large applications (such as Microsoft 
Word) on slower PC's may not be able to keep up with SpeedType and may drop some 
characters.  To get around this problem you can set SpeedType to pause X milliseconds after 
every N keystrokes in the Preferences dialog box. 

Compatibility With Other Applications 

SpeedType works with most Windows application that uses the normal Windows keyboard 
messages as input.  Applications that takes its input directly from the keyboard hardware 
interrupt (such as DOS applications) will not work with SpeedType.  SpeedType uses the 
Windows hooks mechanism to insert characters into the keyboard message queue.  SpeedType 
may be incompatible with other macro applications that employ keyboard hooks to translate or 
play back keyboard characters.  If you find that SpeedType does not work with a certain 
application, you can usually solve the problem by loading SpeedType after the other application. 

Security Issues 

SpeedType may not work with applications that use the Windows NT security functions to 
prevent other applications (such as SpeedType) from monitoring their keyboard input.   

Using the Clipboard to Transfer Text 

If the Simulate Clipboard Paste box is checked in the Preferences dialog box, SpeedType uses the 
Windows Clipboard to transfer text if and only if the text to be transferred does not contain 
{@KEY} or {@PAUSE} tags.  For text to be transferred through the clipboard, the application 
receiving the text must recognize the standard Shift+Insert key command to paste text from the 
Clipboard.  Some older applications do not recognize Shift+Insert as the paste command; you 
can change the paste command in the Preferences dialog box. 

The Backspace Key 

AutoReplace works only with applications that process the Backspace key.  If an application does 
not recognize the Backspace key (such as some terminal emulators), you can still use SpeedType 
to insert characters by first pressing the hot key then typing the keyword. 
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Stuck Keys 

There may be instances while you type that you get strange results like beeps while you type, 
menus popping up when you type something or capitalized letters appearing even though the 
shift or CAPS LOCK keys aren't pressed.  The reason is that SpeedType is simulating keytrokes 
too fast and your word processor missed some keystroke commands from SpeedType so 
Windows thinks that the Ctrl, Alt, or Shift keys are being pressed when they are really not.  
 
To get Windows back in sync, press and release the Ctrl, Alt and Shift keys on the right side of 
your keyboard. Bringingup SpeedType by clicking on its icon in the system tray then clicking the 
HIDE button will also put the keyboard back in sync. 
 
To avoid this problem, you will need to slow down SpeedType: 
1. Choose Preferences from SpeedType's File menu. 
2. Set the Pause setting to "Pause 30 msec every 1 keystrokes". 
3. Make sure the Verify Target Window Receives Keystrokes box is checked. 
 
If you are using SpeedType to simulate keystrokes to open a new window or switch to a 
different window you should insert an {@PAUSE} tag immediately before the keystroke 
command to open or switch to a new window.  This gives Windows time to process the 
keystrokes correctly. 
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Common Problems 

 

SpeedType does not work at all; it doesn’t pop up when I press the hot key and abbreviations 
are not recognized.  

Cause: SpeedType is not tracking your keystrokes or another application may be interfering with 
SpeedType.  
Possible Solutions:  
 Check if SpeedType is running:  See if there is a SpeedType icon (the lightning bolt icon) in 

the SYSTEM TRAY (the little window on the lower right corner of your screen that shows the 
time).  If you don't see the SpeedType icon, SpeedType is not running and you will need to 
launch SpeedType from Windows (see Starting SpeedType). 

 Check if AutoReplace is enabled: If there is a SpeedType icon in the system tray, click on it 
with your left mouse button. This should bring up the SpeedType main window.  Make sure 
the AutoReplace box (upper right corner of the SpeedType window) is checked; SpeedType 
will not replace abbreviations if this box is not checked.   

 Make sure SpeedType is tracking your keystrokes:  Click on the SpeedType icon in the 
system tray to bring up the SpeedType main window.  Click the Hide button in the 
SpeedType window to make the SpeedType window disappear; SpeedType should now be 
tracking your keystrokes.  You normally need to click the Hide button to ensure that 
SpeedType tracks your keystrokes. 

 Make sure SpeedType is compatible with your word processor:  Close all applications and 
see if SpeedType works with the Windows NOTEPAD or WORDPAD. SpeedType works best if 
it is loaded after all other applications. 

 Make sure there is no other application that monitors your keystrokes:  SpeedType may not 
work correctly with applications that also monitor your keystrokes.  Examples are: spell 
checkers, other word expanders, mouse utilities (e.g. Microsoft PowerToys), and 
programmable keyboards/mice.  If you have such a program, try disabling it and see if 
SpeedType works. 

 
SpeedType's Suggestion Window is useful to quickly determine if SpeedType is working or not: 
 
1. Click the SpeedType icon in the system tray to bring up SpeedType. 
2. Choose Preferences from SpeedType's File menu. 
3. Select the 4. AutoReplace tab. 
4. Select the Show Suggestion Window check box 
5. Click OK.  You should now see the Suggestion Window floating on your screen (you can 

move and resize the window).  Now whenever you type something, you should see the most 
recent word displayed in the Suggestion Window; this should help you determine if 
SpeedType is correctly tracking your keystrokes. 

 
 

SpeedType is able to expand abbreviations but the text is not inserted correctly. 

Cause:  There may be an incompatiblity problem. 
Solution: 
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The common solutions are: 
1. Slow down SpeedType.  See the next question for how to do this. 
2. Run SpeedType last.  That is, run all your applications first then run SpeedType. 
3. Change the Text Transfer method. SpeedType has two methods for transferring text: by 

keyboard simulation and by simulating the clipboard paste operation. If you encounter a 
problem inserting text into an application, try changing the text transfer method in 
SpeedType's Preferences box. 

 

When SpeedType plays back text, the first character of the keyword is not erased. Keystrokes or 
characters are also sometimes lost after SpeedType expands a keyword.  

Cause: Your word processor cannot process the keystrokes fast enough.  
Solution: Choose Preferences from the File menu and increase the delay between keystrokes to 
something like "Pause 30 msec every 1 keystrokes". This will slow down SpeedType. It is also 
recommended that you do not enable the Suggestion Window  or Hint window on older 
computers that cannot keep up with your typing speed. 
 

I get extra spaces in Microsoft Word. 

Cause: MS Word adds an extra space if you set SpeedType to Simulate Clipboard Paste as the 
text transfer method, or Word's AutoCorrect function is interfering with SpeedType. 
Solution: See the section on Using SpeedType with Microsoft Word. 
 

Playback is extremely slow. 

Cause: Your system may be too busy. 
Solution: Try increasing SpeedType's speed: Choose Preferences from the File menu and 
increase the delay between keystrokes to something like "Pause 50 msec every 40 keystrokes".  
This will make SpeedType run at full speed and pause after every 40 simulated characters.  The 
pause is necessary to allow your word processor to catch up. 
 
You may also want to check your hard disk for errors: 
 
1. In your Windows desktop, open the My Computers icon. 
2. Click the right mouse button over the C: hard drive icon. 
3. Choose Properties 
4. Choose the Tools tab. 
5. Click the Check Now button to check the hard drive for errors. 
6. Click the Defragment Now button to defragment your hard drive. 
 

SpeedType does not play back all text; some keystrokes are being lost. 

Cause:  SpeedType is playing back text faster than the target window can process them. 
Solution:  This frequently occurs if SpeedType plays back large amounts of text and your word 
processor needs to redisplay or scroll down the page.  Slow down SpeedType by increasing the 
delay between keystrokes to something like "Pause 30 msec after every 1 keystrokes".  You can 
also insert {@PAUSE} tags in your SpeedType text to simulate short pauses. 
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SpeedType does not work with Microsoft Word 

Cause: Possible conflict with Microsoft Word settings. 
Solution: See the section on Using SpeedType with Microsoft Word.  
 

SpeedType does not expand keywords all the time in spreadsheets such as Microsoft Excel. 

Cause: Excel and most other spreadsheets create a new edit window after the first keystroke. 
This may confuse SpeedType. 
Solution: Type F2 to enter the spreadsheet’s edit mode before typing SpeedType’s keyword. Or 
you can type a SPACE followed by SpeedType’s keyword. 
 

The keyboard does not respond to keystrokes.  

Cause: SpeedType may have gotten out of sync with your word processor.  
Solution: Bring up SpeedType’s main window by clicking on the SpeedType icon in the Windows 
system tray. Click the Hide button to send SpeedType to the background. If your keyboard still 
doesn't work, shut down and restart SpeedType.  
 

A GPF occurs when SpeedType inserts text. 

Cause: Possible incompatibility with another application. 
Solution: Try launching SpeedType after all other applications. 
 

A GPF occurs after opening a large dictionary or adding/editing a keyword. 

Cause: Windows has run out of resources.  
Solution: Split the large dictionary into smaller files, shut down unneeded applications or get 
more memory for your computer. 
 

Trailing spaces at the end of inserted text are not being transferred. 

Cause: MS Word removes off trailing spaces from text transferred through the clipboard. 
Solution: See the section on Using SpeedType with Microsoft Word. 
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SpeedType and Medrite 

 
To make SpeedType work with Medrite XL you will need to disable the Medrite glossary: 
 
An administrator on the system needs to launch the  
Medrite-XL Console program. 
 
Click on Profiles | Transcriptionist and select the transcriptionist. 
(Make sure the transcriptionist is currently not running the transcription program!) 
 
In the profile window, click on the "Personal Info" tab. 
 
Under the group "Chars to expand glossary", select "No Glossary". 
Click on the "Update" button to apply the change. 
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SpeedType and Citrix 

 
OfficeSoft has not officially tested SpeedType with Citrix but we do have customers who told us 
they use SpeedType on Citrix with no problems; here's what they told us (in their own words):  
 
"To use SpeedType with a word processor on Citrix, you have to push out a Desktop session to 
the end users.  You CANNOT use the Published Applications session because, if you do this, 
SpeedType and your word processor will be on two separate sessions and SpeedType therefore 
cannot communicate with the word processor on the other session. When you push the Desktop 
session to the end user, you are giving them a single session to run all their applications they 
need." 
 
Please note that you must purchase a site license to cover all persons  using SpeedType off the 
server. 
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SpeedType and Windows Server 

 
What you will need to do is install and run SpeedType off the Server and not on the client PC. 
 
1. Install SpeedType on your Windows Server machine. 
 
2. On your client machine run SpeedType from the server. 
 
Please note that you must purchase a site license to cover all persons using SpeedType off the 
server. 
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SpeedType 10.x Order Form 

Order forms and instructions are available from the SpeedType Web Site @ 
www.speedtype.com and click on the Order Software option. 
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Editing the Dictionary 

 
How to add entries to the dictionary.  
 
How to change an entry.  
 
How to remove an entry.  
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Dictionary Text Dialog Box 

The Dictionary Text Dialog Box appears when you choose Add, Modify or Duplicate from the 
Dictionary menu.  The Dictionary Text Dialog Box allows you to add or modify a dictionary entry.  
You can specify the keyword, description, text and shortcut key for a dictionary entry. 
 
The Dictionary Text Dialog Box has the following fields: 

Keyword Box 

This box holds the keyword (abbreviation or short form; 1 to 32 characters in length) that 
represents this dictionary item. 

Shortcut Button 

Click this button to bring up the Select Shortcut Key dialog box. 

Text To Type Box 

This box holds the text to type (long form) as well as any embedded tags.  To insert a tag, click 
the Tags button or click your right mouse button anywhere inside the Text To Type box.  The 
text font can be changed with Editor Font button in the Preferences Dialog Box.  Note that text 
font is for display purposes only and does not affect the way SpeedType plays back the text in 
your word processor. 
 

Tip: If you need to simulate bold face, underlining, supercripts, etc. in your word 
processor, click here for some examples. 

 
[Options] 
Click [Options] to display a pop up menu of editor control options. Note that the options affect 
only the way you enter text in the Text to Type box; the options do not affect how SpeedType 
plays back the text.  The menu items are: 
 

Word Wrap  

If checked, long lines in the Text To Type Box will wrap over to the next line. 

 
[TAB] Key = Tab Character  
If checked, pressing the TAB key will insert a tab character in the Text to Type box.  If 
this option is not checked, pressing the TAB key will select the next control in the dialog 
box. 

 
[ENTER] Key = New Line  
If checked, pressing ENTER will insert a new line (i.e. a carriage return/line feed) in Text 
to Type box.    If this option is not checked, pressing ENTER is equivalent to clicking on 
the OK button.  If your word list consists primarily of one line text, you may want to 
consider unchecking this option to save time when defining new dictionary items. 
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Description Box 

This box holds a description or comment of this dictionary entry.  The description appears in the 
Dictionary list box displayed in the Main Window.  If the description is blank, SpeedType will 
display the first 60 characters in the Text to Type box in the Dictionary list box.  Note that the 
Description box is for display purposes only; do not confuse the Description box with the Text To 
Type box. 
 

Tip:  If you want to skip over the Description Box when you press TAB from the Text to 
Type box,  use your mouse to right click on the Description box and uncheck the Enable 
Tabstop option. 
 

Record Button 

Use the Record button to tell SpeedType to record keystrokes and store them in the Text to 
Type box.  After you click on the Record button, SpeedType displays on the upper right corner of 
your screen a small window containing a Stop and a Cancel button.  Almost anything you type 
will be recorded by SpeedType.  (Note that only keystrokes are recorded; mouse activities are 
not recorded.  SpeedType currently does not support some keystroke combinations involving 
system keys such as the Print Screen, Scroll Lock, Pause and some combinations involving the 
Windows key; you may have to do some experimentation to see what works). 
 
To stop the recording click on the Stop button (alternate method: clicking on the SpeedType 
system tray icon will also stop the recording). The recorded keystrokes will then be appended to 
the Text to Type field (click the UNDO button if you need to cancel). 
 
The RECORD feature is especially useful in generating the correct {@KEY} sequences to 
automate navigating through menus and windows. 
 

Important:  If you modify the dictionary it is strongly recommended that you backup the 
dictionary files at regular intervals. 
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Select Shortcut Key Dialog Box 

The Select Shortcut Key dialog box is used to define a shortcut code to represent a keystroke 
combination. 

Ctrl, Alt, Shift Boxes 

The group of checkboxes determines if the Ctrl, Alt, and/or Shift keys are to be combined with 
the key 

Next Key Typed Button 

When you click this button, SpeedType will automatically generate the correct shortcut code for 
you from the next keystroke you type in. 

Clear Button 

Click this button to clear a previously defined shortcut code. 
 

Notes: 

 The following keys cannot be defined as shortcut keys:  NumLock, Print Scrn/Sys Req, Tab, 
and the Windows key on Microsoft Natural Keyboards. 

 Some keys (such as the '/' key) appear on the regular keyboard and on the numeric keypad.  
To distinguish the keys that are located on the numeric keypad, the word "NumPad" will 
appear before the key name 
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Preferences Dialog Box 

Choosing "Preferences" from the File menu brings up the Preferences Dialog Box.  There are five 
tabs:   
 Operation  
 Display 
 File Shortcuts 
 AutoReplace 
 Links  
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Operation Preferences 

Choosing "Preferences" from the File menu brings up the Preferences Dialog Box.  Click on the 
Operation tab to access Operation Preferences. 

Hot Key Button 

Click this button to define a new hot key. 

Paste Key Button 

Click this button to define the keystroke SpeedType will use to simulate a Clipboard paste.  Most 
applications recognize either Shift+Insert or Ctrl+V as the clipboard paste command. 

Pause 

Use this option to add a delay (in milliseconds; 1000 msec = 1 second) after a specified number 
of keystrokes.  This option is useful if you find that SpeedType is playing back text too fast for 
the target application to handle. 
 

Verify Target Window Receives Keystroke 

When this option is checked, SpeedType waits for a keystroke to be properly received by the 
target window before playing back the next keystroke; this prevents SpeedType from 
accidentally overrwriting text in another window.  The disadvantage is that, on some systems, 
this could result in very poor playback performance.  Unchecking this box causes SpeedType to 
playback keystrokes at maximum speed without verifying if the keystrokes reach their intended 
target.  If you experience lost or transposed keystrokes, use the Pause option above to slow 
down SpeedType. 

Beep When Hot Key Pressed 

When this option is checked, the PC speaker will beep whenever you hit the hot key or a 
shortcut key. 

Beep When Typing Empty Text String 

When this option is checked, the Windows Exclamation sound will be played when SpeedType 
has nothing to type (that is, when there is no text in the Text to Type box; this can occur if you 
enter a non-existent keyword and press the ENTER key).  You can change the Exclamation sound 
through the Sound icon in the Windows Control Panel. 

Beep After Text Transferred 

When this option is checked, the PC speaker will beep when SpeedType has finished transferring 
the text to the word processor. 

Simulate Clipboard Paste 

When this option is checked, SpeedType uses the Clipboard to transfer the text that do not 
contain (@KEY} tags.  The advantages of using the Clipboard to transfer text are: fast text 
transfers and support for extended characters and international (not United States) keyboards. 
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Simulate Keystrokes 

When this option is checked, SpeedType tries to type the text by simulating keyboard input. 
The advantage of using keyboard simulation to transfer text is: that this method works with 
most Windows applications when typing standard ASCII characters.  The disadvantages of using 
keyboard simulation to transfer text are slow text transfer with certain applications,  the 
possibility that it may not work with certain applications when typing extended characters, and 
the possibility that it may not work with certain applications when using a non-U.S. keyboard. 
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Display Preferences 

Choosing "Preferences" from the File menu brings up the Preferences Dialog Box.  Click on the 
Display tab to access Display Preferences. 

Editor Font Button 

You can change the font of the characters in the Text to Type box and input dialog windows with 
this button. 

Main Window Color Button 

You can change SpeedType's Main Window color with this button. 

Dictionary List Font Button 

You can change the font of the characters in the Dictionary List box with this button.   

Dictionary List Keyword Color Button 

You can change the color of the characters in the Keyword column of the Dictionary List box 
with this button. 

Suggestion Window Font Button 

You can change the font of the characters in the Suggestion Window with this button. 

Suggestion Window Color Button 

You can change the Suggestion Window color with this button. 

AutoSave 

When this option is checked, SpeedType will automatically save any modifications you made 
when you either click the Hide button or close the dictionary.  You would normally want to 
enable the AutoSave feature as it may prevent loss of data due to power outages or system 
crashes.  If you do not enable this option, you must remember to choose Save from the File 
menu to save the file. 

Do Not Confirm Exit 

By default, when you select Exit from the File menu, SpeedType will display a dialog box and ask 
you to confirm if you really want to shut down SpeedType.  To disable this feature, check the Do 
Not Confirm Exit option box. 

Hide on Start Up 

If checked (the default), the Main Window is automatically hidden when you start SpeedType. 
Uncheck this box if you wish the Main Window to be visible when SpeedType is started. 
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File Shortcuts Preferences 

Choosing "Preferences" from the File menu brings up the Preferences Dialog Box.  Click on the 
File Shortcuts tab to access File Shortcuts Preferences. 
 
The list box displayed on this page shows the shortcuts linked to dictionary files or external 
programs.  When you press one of the shortcuts in this list, SpeedType will open or launch the 
associated file.  You add a new entry by clicking the Add button.  Modify an existing entry by 
clicking the Edit button.  Delete an existing entry by clicking the Remove button. 
 
You can also use Windows Explorer to drag and drop files directly into the list box. 
 
The contents of the list box also appears in the Shortcuts menu in the Main Windows.  You can 
change the order of the list items by dragging an item with the left mouse button. 
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AutoReplace Preferences 

Choosing "Preferences" from the File menu brings up the Preferences Dialog Box.  Click on the 
AutoReplace tab to access AutoReplace Preferences. 

AutoReplace Options 

Enable AutoReplace 

If this box is checked, AutoReplace will be enabled. 

Enable Automatic Keyword Completion 

When this option is checked, SpeedType will find the nearest keyword whenever you type two 
or more commas after a word. 

Beep on Keyword 

When this option is checked, SpeedType will beep the PC speaker whenever a recognized 
keyword is detected. 

Use Shift+Enter to expand keyword immediately 

When this option is checked, typing Shift+Enter after a valid keyword will expand that keyword 
immediately; the word processor does not receive the Shift+Enter keystroke.  Unselect this 
option if you want SpeedType to pass the Shift+Enter through to your application.  NOTE: this 
option is included for compatibility with previous versions of SpeedType and may go away in the 
future; the preferred method to expand keywords immediately is to press the Tab key. 

Use Ctrl+Space to insert a space without expanding keyword 

When this option is checked, typing Ctrl+Space after a valid keyword will not expand that 
keyword; the word processor does not receive the Ctrl+Space keystroke.  Unselect this option if 
you want SpeedType to pass the Ctrl+Space through to your application. 

Use Alt+Ins to add current word to dictionary 

When this option is checked, typing Alt+Ins after a word that is at least 3 characters long will add 
that word to the SpeedType dictionary; the word processor does not receive the Alt+Ins 
keystroke.  Unselect this option if you want SpeedType to pass the Alt+Ins through to your 
application.  Click on [Options] to change the prefix and/or suffix added to the keyword 
automatically created by SpeedType. 

Remember Last Expanded Word 

When this option is checked,  pressing BACKSPACE after an expansion will place the last 
expanded word into SpeedType's keyboard buffer; this feature is useful if you need SpeedType 
to type out the first part of an abbreviation for you. For example, if you have the following 
entries: 
 

Keyword Text to Type 
tp the patient is a g 
g1 male 
g2 female 
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If you now type: 
      
   tp<SPACE><BACKSPACE>1<SPACE> 
 
you will get: 
 
   the patient is a male 
 
Note: This works only with simple long forms and the remembered word is restored only after 
you hit BACKSPACE after the expansion.  Entries with @Tags (e.g. if you use the @KEYDOWN 
and @KEYUP commands to simulate a Ctrl or Shift key) may not be tracked correctly; if you plan 
on using this feature a lot, we recommend you turn on the Suggestion Window to view how 
SpeedType tracks your keyboard input.   
 

Tip:   If the SpeedType keyboard buffer gets messed up, press ESC to reset the buffer. 
 

Support On-Screen Keyboards 

When this option is checked,  SpeedType will be able to expand abbreviations typed through 
onscreen (software) keyboards.  When this option is not checked, clicking the mouse on a 
different window will reset SpeedType's keyboard tracker.  If you don't plan on using onscreen 
keyboards, we suggest disabling (unchecking) the Support On-Screen Keyboards option to 
prevent unwanted expansions in the wrong window. 

AutoReplace Suggestion Window 

Show Hint Window Only If Keyword Detected 

When this option is selected, SpeedType will display a small, yellow  AutoReplace Window 
whenever a recognized keyword is detected.  The AutoReplace Window is normally positioned 
below the active window. 

Show Suggestion Window 

When this option is selected, SpeedType will always display a Suggestion Window .  You can 
move and resize the Suggestion Window to a convenient position on your screen.  By default, 
the suggestion selection keys are F1 to F9; click on [Options] to change the suggestion selection 
keys.  
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Links Preferences 

 
Choosing "Preferences" from the File menu brings up the Preferences Dialog Box.  Click on the 
Links tab to access Links Preferences. 
 
The list box displayed on this page contains dictionary files to be linked into the active 
dictionary. You add a new entry by clicking the Add button.  Delete an existing entry by clicking 
the Remove button. 
 
You can also use Windows Explorer to drag and drop files directly into the list box. 
 
The order of the files in the list is significant; SpeedType always loads the dictionaries in the 
order shown with duplicate keywords being ignored.  You can change the order of the list items 
by dragging an item with the left mouse button. 
 
To enable linking, check the Enable Links box.  If the Enable Links box is not checked, no linking 
will occur. 
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File Shortcut Dialog Box 

Use this dialog box to associate a keystroke with a file. 

Dictionary or Program Name Box 

Specify the name of the file in this box.  You can also use the Windows Explorer to drag and drop 
filenames into this box.  If the file is program, you can also specify optional command line 
parameters after the program name.  For example, "NOTEPAD.EXE C:\MYFILE.TXT" will run 
NotePad and command NotePad to open the file C:\MYFILE.TXT. 

Shortcut Button 

Click this button to define the shortcut key associated with the file. If the file is a SpeedType 
dictionary file, SpeedType will open the dictionary whenever you press the specified shortcut 
key.  If the file is a program, SpeedType will launch the program whenever you press the 
specified shortcut key. while SpeedType is running in the background.  The file shortcut keys are 
also recognized if SpeedType's Main Window is the active window. 

Description Box 

Specify a short description in this box.  SpeedType displays this description in the Main 
Window's Shortcuts menu.  If you do not enter a description, SpeedType will automatically 
generate one for you based on the filename you enter in the Dictionary or Program Name box 
above. 
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Text To Type Dialog Box 

The Text To Type Dialog Box is displayed during playback after you enter all the input fields.  If 
you wish, you can use the hot key and shortcut keys to insert additional text into the Text To 
Type Dialog Box. 

Type It Button 

Clicking this button or pressing the Enter key will transfer the text to word processor if there are 
no {@INPUT} tags found in the text.  If there are {@INPUT} tags present, SpeedType will ask for 
input until all the {@INPUT} tags are filled. 

Print Button 

Clicking this button will send the text to the printer if there are no {@INPUT} tags found in the 
text.  If there are {@INPUT} tags present, SpeedType will ask for input until all the {@INPUT} 
tags are filled. 

Undo Button 

Click this button to undo the last edit action. 

Restart Button 

Click this button to discard all changes and restart from the beginning. 

Cancel Button 

Click this button to abort and return to your word processor. 
 
 

Notes: 

 To enter the tab character, press Ctrl+Tab. 
 To enter a new line, press Ctrl+Enter 
 You can change the text font with the Preferences Dialog Box. 
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Text To Type Preview 

SpeedType displays the Text To Type Preview box when you click on the Preview button from 
one of the input dialog boxes.  (SpeedType displays an input dialog box whenever it encounters 
a User Input tag like {@INPUT} ). The Text To Type Preview box shows you the current state of 
the text that will be typed.  Unfilled input fields are represented by the string "(@INPUT FIELD 
#n}". 

Save Session 

Click this button to save the current input session to a file.  This is useful if you cannot complete 
a session and need to finish it at a later time. 

Restore Session 

Click this button to restore a previously saved input session.  The current session will be 
replaced by the restored session. 
 

Customizing How Sessions are Save/Restored 

By default, sessions are saved/restored to a file on your hard disk.  You can change the way 
sessions are saved/restored (e.g. encrypt it first before saving) by creating Tcl scripts.   
 
To change the way sessions are saved, create a Tcl proc called sh_OnSaveSession of the form: 
 
   proc sh_OnSaveSession {data} { 
      # $data is the session data. 
      # Put your code to save $data here ... 
      return "SH_CANCEL"; # returning string "SH_CANCEL" quits  
                          # the session immediately; 
                          # any other string returns to the  
                          # input session 
   
 
To change the way sessions are restored, create a Tcl proc called sh_OnRestoreSession 
 
   proc sh_OnRestoreSession {} { 
      # code to read session data ... 
      return $data; # return the session data 
  
 

Example 

 
This sample code simply saves/restores the session data to a file.  You can use this code as a 
starting point to write your own customized session save/restore functions. To use this sample 
code, copy it to your SPEEDTYPE.TCL file in the SpeedType folder and restart SpeedType 
(SpeedType always executes SPEEDTYPE.TCL on startup). 
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# This proc displays a "Save" dialog window and saves the 
# session to the user specified file. 
proc sh_OnSaveSession {sessionData} { 
  # display Save As dialog box 
  set filename [sh_input save "Save Session" -filter "SH Input Session (*.spi)|*.spi"]; 
  if {$filename == "SH_CANCEL" } { 
    return ""; 
  } 
  # append '.SPI' to filename if no extension was specified 
  if {[file extension $filename] == ""} { 
    set filename "${filename}.spi" 
  } 
  # Save the session date 
  if [catch {open $filename w} fileID] { 
    sh_input msg "" "Error in sh_OnSaveSession: Cannot open $filename"; 
    return ""; 
  } 
 
  # save to file 
  puts -nonewline $fileID $sessionData; 
  close $fileID; 
  return SH_CANCEL; # tells SpeedType to abort input session and return to word processor 
} 
 
# This proc displays an "Open" dialog window, reads the contents 
# of the file and returns it to SpeedType. 
proc sh_OnRestoreSession {} { 
  # display  Open dialog 
  set filename [sh_input open "Restore Session" -filter "SH Input Session (*.spi)|*.spi"]; 
  if {$filename == "SH_CANCEL"} { 
    return ""; 
  } 
  # append '.SPI' to filename if no extension was specified 
  if {[file extension $filename] == ""} { 
    set filename "${filename}.spi" 
  } 
  # open session file 
  if [catch {open $filename r} fileID] { 
    sh_input msg "" "Error in sh_OnRestoreSession: Cannot open $filename"; 
    return ""; 
  }  
 
  # read file 
  set sessionData [read $fileID]; 
  close $fileID; 
  return $sessionData; 
} 
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Pick List Input Dialog Box 

SpeedType displays the Pick List Input Dialog Box during playback whenever the current 
{@INPUT} tag  contains pick list items.  Select one or more items from the pick list by using the 
left mouse button or the space bar. 

Incremental Search Box 

When you type into this box, the pick list will highlight closest matching item.  You can use the 
up and down arrow keys to scroll through pick list.  Use the space bar to select/unselect the 
current item.  To enter a space character, press Ctrl+Space or Shift+Space. 

Columns Box 

Use this box to control the maximum number of columns that can appear in the pick list. 

Select All Button 

Click this button to select all items. 

Clear Button 

Click this button to clear all selections. 

Next Button 

Click this button or press the Enter key to replace the {@INPUT} tag with the selected item(s) 
and proceed to the next @INPUT tag. If there is no other {@INPUT} tag, you will return to the 
Text To Type Dialog Box. 

Back Button 

Click this button to back up to previous {@INPUT} tag. 

Restart Button 

Click this button to restart from the first {@INPUT} tag. 

Preview Button 

Click this button to display the Text To Type Preview Box. 

Cancel Button 

Click this button to abort and return to your word processor. 
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Date Input Dialog Box 

SpeedType displays the Date Input Dialog Box whenever an {@INPUTDATE} tag is encountered 
during playback. 

Date Box 

Enter the date in this box.  You can use the +,- keys to increment or decrement the date.  You 
can also click the button that appears to the right of the Date Box to bring up a calendar. 

Select Date Style 

Select the date format from the style options.  The styles are based on the Windows Long Date 
Format and Short Date Format which you can change in the Regional Settings of the Windows 
Control Panel. 

Next Button 

Click this button or press the Enter key to replace the {@INPUTDATE} tag with the specified date 
and proceed to the next {@INPUT} tag. If there is no other {@INPUT} tag, you will return to the 
Text To Type Dialog Box. 

Back Button 

Click this button to back up to previous {@INPUT} tag. 

Restart Button 

Click this button to restart from the first {@INPUT} tag. 

Preview Button 

Click this button to display the Text To Type Preview Box. 

Cancel Button 

Click this button to abort and return to your word processor. 
 



 162

Free Form Input Dialog Box 

SpeedType displays the Free Form Input Dialog Box during playback whenever an {@INPUT} tag 
is encountered.  Enter the desired information into the text box.  Use Ctrl+Enter to insert a new 
line and Ctrl+Tab to insert tabs. 

Next Button 

Click this button or press the Enter key to replace the {@INPUT} tag with the specified text and 
proceed to the next {@INPUT} tag. If there is no other {@INPUT} tag, you will return to the Text 
To Type Dialog Box. 

Back Button 

Click this button to back up to previous {@INPUT} tag. 

Restart Button 

Click this button to restart from the first {@INPUT} tag. 

Preview Button 

Click this button to display the Text To Type Preview Box. 

Cancel Button 

Click this button to abort and return to your word processor. 
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Dictionary Info Box 

Choose Info from the Dictionary Menu to display the Dictionary Info Box.  The Dictionary Info 
Box displays information concerning the dictionary. 
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Tcl Script Dialog Box 

Tcl Script Box 

Enter a Tcl script in this box.  If you are not familiar with Tcl, please consult the TclReadme.txt 
file for more information on this powerful programming language. 
 

Eval Script Button 

Click this button to evaluate the script in the Tcl Script Box.  The result will be displayed in the 
box directly below this button. 
 
See Also:  Tcl Extension Commands  
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SpeedType Web Site 

For sales or technical assistance, please contact your authorized SpeedType representative 
directly.  Your authorized SpeedType representative is displayed in SpeedType’s About box 
(select About from SpeedType’s Help menu). www.speedtype.com 
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Define @INPUT Tag Dialog Box 

Use this dialog box to define {@INPUT} tags.  SpeedType will pause to accept input whenever it 
encounters an {@INPUT} tag. 

Prompt Box 

Use this box to specify the prompt that will be displayed to the user. 

Variable Name Box 

Use this box to define a replaceable variable.  You can leave this box blank if you do not want to 
define a replaceable variable.  For example, if you enter "color" for the Variable Name, 
SpeedType will replace all instances of the string "{color}" in the Text to Type box with the user 
input. 

Optional Pick List Box 

Use this box to enter pick list items.  Each item must be entered on a separate line.  If a {@REM 
caption} tag is present in a pick list item, the caption  will be displayed in the pick list instead of 
the entire pick list item string. 

Allow Multiple Selections Check Box 

If this box is checked, the user is allowed to select one or more items from the pick list.  If this 
box is not checked, the user can select only one item. 
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AutoReplace Hint Window 

The first line in the AutoReplace Window shows the current word you are typing.  If the word is 
a recognized keyword, the keyword's description is displayed in the second line. 
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SHCNV - SpeedType File Converter Utility 

Run the SHCNV utility by choosing “Run File Converter” from SpeedType’s File menu. 
 
SHCNV is a utility to convert MS Word AutoCorrect entries, PRD+, Abbreviate!, Smartype, 
formatted ASCII text files and older SpeedType (v4.x and earllier) dictionaries to the SpeedType 
10.x dictionary format. Files created by SpeedType 5.x through 9.x do not need to be converted 
to SpeedType 10.x.  This utility can also be used to merge two SpeedType 10.x dictionaries. 
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Remove (Cut) Command 

Choosing "Remove (Cut)" from the Dictionary menu will delete the selected item(s) from the 
dictionary.  The deleted items are placed in the clipboard so you can restore them by choosing 
Paste from the Dictionary menu. 
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Left Click 

Point the mouse arrow to the item of interest then click the left mouse button. 
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Shift+Left Click 

Point the mouse arrow to the item of interest then, while pressing down the Shift key, click the 
left mouse button. 
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Alt+Ins Options 

 
Clicking on the [Options] Link next to "Use Alt+Ins to add current word to dictionary" in the "4. 
AutoReplace" tab of the Preferences window brings up the Alt+Ins Options dialog box. 
 
When Alt+Ins is enabled, pressing Alt+Ins will add the last word you typed to the active 
SpeedType dictionary.  You can specify an optional prefix or suffix to the keyword created by 
SpeedType. 
 

Keyword Prefix box 

Enter the string you want added to the beginning of the keyword created by SpeedType.  By 
default, SpeedType uses a blank string for the prefix 
 

Keyword Suffix box 

Enter the string you want added to the end of the keyword created by SpeedType.  By default 
this is " ."  (a space and a period). 
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Suggestion Window Options 

 
Clicking on the [Options] Link next to "Show Suggestion Window" in the "4. AutoReplace" tab of 
the Preferences window brings up the Suggestion Window Options dialog box. 
 

Suggestion Shortcut 

By default, F1 to F9 will select a word from the Suggestion Window.  You can add a Ctrl, Alt, 
and/or Shift modifier to the function keys by checking the appropriate boxes. 
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